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関連アプリケーション ノートとサンプル コード：ここをクリックしてください 
  

さらにサンプルコードをお求めでしょうか？以下のとおり対応いたします。 

PSoC サンプル コードのリストにアクセスするには、サンプル コードのウェブ ページをご覧ください。PSoC ビデオライブ

ラリについてはここからご覧ください。 

本アプリケーションノート(AN210781) では、Bluetooth Low Energy (BLE) 接続機能を備えた PSoC® 6 MCUをご紹

介します。本 MCU は、BLE 5.0 システム、最新の CapSense®技術および多数のセキュリティ機能を統合する、 

デュアル CPU Arm® Cortex®-M4 および Cortex-M0+ベースのプログラマブルシステムオンチップです。本アプリ 

ケーションノートをとおして、開発者のお客様が BLE接続搭載の PSoC 6 MCUのアーキテクチャおよび各種の開発 

ツールを探究できるほか、初めて PSoC Creatorを使用してプロジェクトをビルドし、サードパーティ製統合開発環

境(IDE) へエクスポートしてから、ファームウェア開発を継続する方法も示します。PSoC 6 MCUデバイスファミリ

の使用については、AN221774 – Getting Started with PSoC 6 MCUを参照してください。 
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1 はじめに 

BLE接続機能を備えた PSoC 6 MCU (以下、「PSoC 6 BLE」) は、ウェアラブルおよび IoT 製品専用に設計されたサ

イプレスの超低消費電力 PSoCデバイスです。これは、今日の「常時オン」アプリケーションのための新しい低電力

規格を確立します。サイプレス PSoC 6 BLEデバイスは、以下をシングルチップに統合するプログラム可能な組込み

システムオンチップです。 

▪ デュアル CPUマイクロコントローラー: CM4および CM0+ 

▪ BLE 5.0サブシステム 

▪ プログラム可能なアナログおよびデジタル周辺機器 

▪ 最大 1 MBのフラッシュと 288 KBの SRAM 

▪ 第 4世代の CapSense技術 

PSoC 6 BLEは、次のような電源に敏感なさまざまな接続アプリケーションに適しています。 

▪ スマート ウォッチとフィットネス トラッカー 

▪ コネクテッド医療機器 

▪ スマートホームのセンサー／コントローラー 

▪ スマート家電製品 

▪ ゲーム コントローラー 

▪ スポーツ、スマートフォン、バーチャル リアリティ (VR) アクセサリ 

▪ 産業用センサー ノード 

▪ 産業用ロジックコントローラー  

▪ 高級リモートコントローラー 

PSoC 6 BLEは、MCUと BLE無線ブロックの組合せの、費用対効果が高く、フットプリントが小さい代替品です。

プログラマブル アナログとデジタル サブシステムにより、PSoC 6 BLE アプリケーションを開発するための回路図

ベースの設計ツールである PSoC Creatorを使用して、設計の柔軟性および動的な微調整を実現できます。BLEアプ

リケーションを開発する際に、複雑な BLE プロトコル スタックの実用的な知識は必要ありません。サイプレスは

PSoC Creator で、プロトコルの複雑さを簡素化する、設定しやすい GUI ベースの BLE コンポーネントを提供しま

す。  

BLEは、Bluetooth Special Interest Group (SIG) によって策定された短距離通信向けの超低消費電力無線規格です。

PSoC 6 BLEは、BLE 5.0仕様準拠のセキュリティ、プライバシー、およびスループットを強化した BLE 4.2無線ブ

ロックとロイヤリティフリーのプロトコルスタックを統合します。 

PSoC 6 BLEの CapSense®というサイプレスの第 4世代静電容量タッチ センシング機能は、比類のない信号対ノイ

ズ比、クラス最高の耐水性、およびボタンやスライダー、トラック パッド、近接センサーなど多種多様なセンサー 

タイプを提供しています。CapSense ユーザーインターフェイスは、活動モニターやヘルスケアおよびフィットネス

機器などのウェアラブル電子機器に幅広く採用されています。CapSense ソリューションは、ノイズのある環境や液

体が存在している状態でも正常に機能します。 

PSoC 6 BLE は、統合されたソリューションで超低消費電力の接続アプリケーションを実現します。図 1 に、PSoC 

6 BLEに基づくフィットネス トラッカーのアプリケーション レベルのブロックダイヤグラムを示します。 

http://www.cypress.com/
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図 1. フィットネス トラッカー アプリケーション ブロックダイヤグラム 

 

このデバイスはワンチップソリューションを提供し、以下が含まれます。 

▪ 最大 4つの同時接続を維持できる低消費電力 BLE 5.0システム 

▪ 超低消費電力動作用の降圧変換器 

▪ 心拍センサー出力を調整、測定し、バッテリ電圧を監視するための内蔵アナログ フロント エンド (AFE) 

▪ グローバル ポジショニング システム (GPS) モジュールを含む複数のデジタル センサーとインターフェースする

ためのシリアル通信ブロック (SCB) 

▪ パルス密度変調 (PDM)／パルスコード変調 (PCM) ハードウェア エンジンおよび音声用デジタルマイク インター

フェース 

▪ 信頼性のあるタッチおよび近接センシング機能を提供する CapSense技術 

▪ クアッド シリアル ペリフェラル インターフェース (QSPI) 対応の外部メモリへのインターフェースをサポート

するシリアル メモリ インターフェース (SMIF) 

▪ ディスプレイとハプティクスデバイスを駆動するためのデジタルロジック (UDB) および周辺機器 (TCPWM) 

デバイスの機能の詳細については、デバイスの特長と Appendix Cを参照してください。 

 

http://www.cypress.com/
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本アプリケーションノートでは、PSoC 6 BLEの機能を紹介し、開発エコシステムの概要を示し、即時アラートサー

ビス (Immediate Alert Service; IAS) に対応した Bluetooth SIG標準のファインド ミー プロファイル (Find Me Profile; 

FMP) の簡単な設計を始める手助けをします。この設計を、サイプレスのキット CY8CKIT-062-BLE 向けのサンプル 

コード CE212736 としても利用できます。本アプリケーションノートでは、このサンプルコードを幅広く使用して

います。 

ハードウェア設計上の考慮事項は、「AN218241 – PSoC 6 MCU Hardware Design Considerations」を参照してくだ

さい。 

高度なアプリケーション開発については、「アプリケーションノート AN215796 – Designing PSoC 6 BLE 

Applications」を参照してください。 

1.1 事前準備 

始める前に、開発キットを入手し、サンプル コードを含む必要なソフトウェアをインストールしてください。 

1.1.1  ハードウェア  

▪ CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit 

▪ Windows 7以降の PC (CySmart™ホスト エミュレーション ツール アプリケーションを使用する場合) 

▪ Android 5／iOS 8以降の携帯電話 (CySmart iOS/Androidアプリを使用する場合) 

1.1.2  ソフトウェア  

▪ PSoC Creator 4.2と PSoC Programmer 3.27 

▪ CE212736 – CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit向けの BLEファインド ミー サンプルコード 

▪ CySmartホストエミュレーションツール PCアプリケーションまたは CySmart iOS/Androidアプリ 

 

CySmartアプリをダウンロードするために、携帯電話で以下の QRコードをスキャンしてください。 

iOS 

 

Android 

 

http://www.cypress.com/
https://developer.bluetooth.org/gatt/services/Pages/ServiceViewer.aspx?u=org.bluetooth.service.immediate_alert.xml
https://developer.bluetooth.org/gatt/services/Pages/ServiceViewer.aspx?u=org.bluetooth.service.immediate_alert.xml
https://www.bluetooth.org/docman/handlers/downloaddoc.ashx?doc_id=239389
https://www.bluetooth.org/docman/handlers/downloaddoc.ashx?doc_id=239389
http://www.cypress.com/CY8CKIT-062-BLE
http://www.cypress.com/an218241
http://www.cypress.com/an215796
http://www.cypress.com/an215796
http://www.cypress.com/cy8ckit-062-ble
http://www.cypress.com/go/cysmart
https://play.google.com/store/apps/details?id=com.cypress.cysmart&hl=en
http://www.cypress.com/psoccreator/
http://www.cypress.com/go/programmer
http://www.cypress.com/ce212736
http://www.cypress.com/CY8CKIT-062-BLE
http://www.cypress.com/go/cysmart
https://itunes.apple.com/us/app/cysmart/id928939093?mt=8
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2 開発エコシステム 

2.1 PSoCリソース 

サイプレスは、www.cypress.com に大量のデータを掲載しており、ユーザーが適切な PSoC デバイスを選択し、設

計に迅速かつ効率的に統合する手助けをしています。以下は PSoC 6 MCUのリソースの要約です。 

▪ 概要: PSoCポートフォリオ, PSoCロードマップ 

▪ 製品セレクタ PSoC 6 MCU 

▪ データシート: 各デバイス ファミリの電気的仕様を

説明します。 

▪ アプリケーションノートおよびサンプルコード: 基

本レベルから上級レベルまでの幅広いトピックを提

供します。アプリケーションノートの多くにはサン

プルコードを含んでいます。PSoC Creator 内部か

ら直接サンプルコードのコレクションも閲覧できま

す。サンプルコードを参照してください。 

▪ テクニカル リファレンス マニュアル (TRM): 各デ

バイス ファミリのアーキテクチャとレジスタの詳

細な説明をします。 

▪ PSoC 6プログラミング仕様: PSoC 6 MCUデバイ

スの不揮発性メモリをプログラムするために必要な

情報を提供します。 

▪ CapSense 設計ガイド: PSoC デバイスを使用して

静電容量タッチセンシングアプリケーションを設計

する方法を学びます。 

▪ 開発ツール 

 CY8CKIT-062-WiFi-BT PSoC 6 WiFi-BT 

Pioneer Kit は、WiFi および BT 接続ととも

に PSoC 62 シリーズ MCUをサポートする

開発キットです。 

 CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit

は、PSoC 6 BLE 向けの使いやすく安価な

開発プラットフォームです。 

▪ トレーニングビデオ: サイプレスは、PSoC 6 MCU

の専用シリーズを含む、当社の製品およびツールに

関するビデオトレーニングを提供します。 

 

PSoC 6 MCUリソースの包括的なリストについては、サイプレスコミュニティの KBA223067を参照してください。 

2.2 ファームウェア／アプリケーション開発 

サイプレス PSoC Creatorとペリフェラル ドライバー ライブラリ (PDL) は開発プロセスの中心です。  

PSoC Creator はアプリケーションを構築するために、いくつかのデジタル／アナログ／システムのコンポーネント

とファームウェアを組み合わせます。PSoC Creator を使用することによって、回路図上のコンポーネントの選択、

配置、構成や C／アセンブリ ソース コードの記述、デバイスのプログラムとデバッグができます。  

PDL は PSoC 6 MCU ファミリ用のソフトウェア開発キットです。ソース コードとして提供される PDL は、サポー

トされるデバイス用のファームウェア開発を容易にします。これにより、レジスタ セットを理解する必要がなくな

り、迅速にファームウェアをカスタマイズして構築できます。PDLは PSoC Creatorとサードパーティ製 IDEの両方

をサポートします。 

2.2.1  PSoC Creator  

PSoC Creatorは無料のWindowsベースの統合設計環境 (IDE) です。このツールにより、お客様は PSoC 6 MCUの

ハードウェアとファームウェア システムを同時に設計できます。図 2に示すように、PSoC Creatorを使用すれば、

以下のことを実現できます。 

1. File > Code Example…メニューからサンプルコードのコレクションを閲覧 

a. デバイスファミリに基づいてサンプルをフィルタリングします。 

b. Filter byオプションに基づいて提供されたサンプルのメニューから選択します。 

c. ダウンロードボタンを使用してサンプルコードをダウンロードします。 

d. 選択に基づいて新しいプロジェクトを作成します。 

2. 100以上のコンポーネントを含むライブラリを探索 

3. コンポーネントをドラッグ＆ドロップして、メイン設計ワークスペースでハードウェア システム設計を構築 

4. コンポーネント データシートを確認 

5. コンフィギュレーション ツールを用いてコンポーネントを設定 

http://www.cypress.com/
http://www.cypress.com/
http://www.cypress.com/psoc
http://www.cypress.com/product-roadmaps/cypress-psoc-and-mcu-portfolio-roadmap
http://www.cypress.com/search/psg/114026#/?_facetShow=ss_pmain_core,ss_psecondary_core,fs_pmax_operating_frequency_mhz_,fs_pflash_kb_,fs_psram_kb_,fs_pno_of_gpios,fs_pble_maximum_data_rate_mbps_,fs_pble_power_output_dbm_,fs_pble_rx_sensitivity_dbm_,fs_pble_supported_frequency_band_ghz_,ss_pdedic
http://www.cypress.com/search/all?f%5B0%5D=meta_type%3Atechnical_documents&f%5B1%5D=resource_meta_type%3A575&f%5B2%5D=field_related_products%3A114026
http://www.cypress.com/psoc6an
http://www.cypress.com/search-results?as_q=psoc%206%20mcu%20code%20examples
http://www.cypress.com/psoc6trm
http://www.cypress.com/documentation/programming-specifications/psoc-6-programming-specifications
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide
http://www.cypress.com/CY8CKIT-062-WiFi-BT
http://www.cypress.com/CY8CKIT-062-WiFi-BT
http://www.cypress.com/cy8ckit-062-ble
http://www.cypress.com/cy8ckit-062-ble
http://www.cypress.com/training/psoc-101-video-tutorial-series-how-use-arm-cortex-m4-based-psoc-6
http://www.cypress.com/training/psoc-101-video-tutorial-series-how-use-arm-cortex-m4-based-psoc-6
http://www.cypress.com/training
https://community.cypress.com/docs/DOC-14644
http://www.cypress.com/psoccreator/
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6. アプリケーションのファームウェアと PSoCハードウェアを相互設計 

 

図 2. PSoC Creatorの回路図エントリ入力コンポーネント 
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2.2.1.1 PSoC Creator ヘルプ 

PSoC Creatorホームページへアクセスして PSoC Creatorの最新版をダウンロードしてインストールしてください。

次に、PSoC Creatorを起動し、以下の項目に移動します： 

▪ クイック スタート ガイド: Help > Documentation > Quick Start Guideを選択します。このガイドは PSoC Creator

プロジェクトを開発するための基礎を提供します。 

▪ サンプルコード: File > Code Exampleを選択するか、Start Pageタブの Find Code Example…リンクをクリック

します。これらのサンプルコードは、PSoCリソースを設定および使用方法を示します。 

▪ コンポーネントデータシート: コンポーネントを右クリックし、Open Datasheet を選択します。すべてのコンポー

ネントデータシートの一覧は、PSoC 6 MCUコンポーネントデータシートページをご利用ください。 

2.2.2  ペリフェラル  ドライバー  ライブラリ  (PDL)  

PDL は、PSoC 6 MCU デバイス用のソフトウェア開発キットです。PSoC デバイスでの作業経験はあるものの、

PSoC 6 MCUを初めて使用する場合、PDLが開発エコシステムへの主要な追加機能であることがわかります。 

レジスタ レベルでのファームウェア開発者であっても、PDL をインストールする必要があります。PDL には、プロ

ジェクトに必要なすべてのデバイス固有ヘッダ ファイルとスタートアップ コードが含まれています。また、各ドラ

イバーのリファレンスとしても機能します。PDLはソース コードとして提供されるため、レジスタ レベルでどのよ

うにハードウェアにアクセスするのかが分かります。 

一部のデバイスは特定のペリフェラルをサポートしていません。PDL は、サポートされているデバイスのすべての

ドライバーのスーパーセットです。このスーパーセット設計は以下のことを意味します。 

▪ ペリフェラルを初期化、設定、利用するために必要なすべての APIがあります。 

▪ PDLは使用可能なペリフェラルに関係なく、すべての PSoC 6 MCUデバイスで有効です。 

http://www.cypress.com/
http://www.cypress.com/psoccreator/
http://www.cypress.com/documentation/component-datasheets/
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▪ PDL は対象となるペリフェラルが選択されたデバイスに存在することを保証するためのエラーチェックを含ん

でいます。 

これにより、ペリフェラルが利用可能である限り、プラットフォームにわたってコードの互換性が維持されます。デ

バイス ヘッダ ファイルは、デバイスで利用できるペリフェラルを指定します。サポートされていないペリフェラル

を使用するコードを記述すると、コンパイル時にエラーが発生します。ペリフェラルを使用するコードを書く前に、

そのペリフェラルのサポートを確認するためにそのデバイスのデータシートを参照してください。 

PSoC Creatorは、PSoC 6 MCUデバイスで使用する PDLに基づいたコンポーネントを提供します。これは、サイプ

レスやコミュニティが開発および事前検証したコンポーネントを利用する PSoC Creator の特長を維持します。しか

し、PDLは任意の開発環境で使用できるソース コード ライブラリです。 

PDLには以下の重要なソフトウェア リソースが含まれています。 

▪ 各ペリフェラル ドライバーのヘッダとソース ファイル 

▪ ミドルウェアライブラリ用のヘッダとソースファイル 

▪ デバイス固有のヘッダ、スタートアップ、およびコンフィギュレーション ファイル 

▪ サポートされるサードパーティ製 IDE用テンプレート プロジェクト 

▪ ドキュメントについて 

ドキュメントの場所は<PDL install directory>\doc\です。2つの重要なドキュメントがあります。  

PDL v3.x User Guideは、以下のような PDLの使用に関する基礎知識について説明します。 

 PDLを使用したカスタム プロジェクトの作成 (サードパーティ製 IDEを含む) 

 ペリフェラルの設定 

 ファームウェアでのピン管理 

 レジスタ ベース プログラミングの学習ツールとして PDLの使用 

 PDL APIリファレンス ドキュメントの使用 

次に重要なドキュメントは、PDL 3.x API Reference Manual.htmlです。このリファレンス ドキュメントには、PDL

のすべてのドライバーに関する完全な情報が記述されています。これには、概要、構成時に考慮すべき事項と、すべ

ての関数、マクロ、データ構造、および列挙型の詳細などが含まれています。 

2.3 他の IDEのサポート 

IAR Embedded Workbenchなどのお気に入りの IDEを使用しても PSoC 6 MCUのファームウェアを開発できます。

PSoC Creator を使用してシステムを設計し、構成コードを生成してターゲット IDE にエクスポートすることにより、

別の IDEで PDLを使用できます。 

詳細については、AN219434 – PSoC 6 MCU Importing Generated Code into an IDEを参照してください。 

2.3.1  他の IDE を対象にした PSoC Creator の使用  

サイプレスは、PSoC Creatorを使用した PSoC 6 MCUシステムリソースとペリフェラルの設定および構成を推奨し

ます。プロジェクトをご使用の IDE にエクスポートし、その IDE でファームウェアの開発を継続します。デバイス 

コンフィギュレーションに変更がある場合は、PSoC Creatorで TopDesign回路図を編集し、対象の IDE用のコード

を再生成します。図 3にこのワークフローを示します。 

http://www.cypress.com/
http://www.cypress.com/an219434
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図 3. PSoC Creatorを使用した PSoC 6 MCUアプリケーション開発フローチャート 
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PSoC Creatorから生成されたコードには、設計に基づく必要なヘッダ、スタートアップ、および PDLファイルのす

べてが含まれます。PSoC Creatorからの生成コードのエクスポートは、Keil µVision、IAR Embedded Workbench、

Eclipse ベース IDE、および GNUベース コマンド ライン ツールでサポートされています。対象の IDEは、Project 

> Build Settings > Target IDEsのパネルで選択します。図 4に示すように、対象の IDEのエクスポート パッケージ

を有効にします。コードを生成すると、PSoC Creatorは対応するエクスポート パッケージも作成します。 

http://www.cypress.com/
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図 4. Project > Build Settingsで対象の IDEを選択 

 

その後、パッケージをご使用の IDEにインポートします。IDEによっては、インポートの詳細は大きく異なります。

実行するプロセスを確認するために、Help > PSoC Creator Help Topicsを選択して、PSoC Creatorヘルプを参照

してください。図 5を参照してください。「Integrating into 3rd Party IDEs」トピックでは、各 PSoCデバイスファ

ミリおよびサポートされている各 IDEの特定のヘルプファイルを紹介しています。 

図 5. PSoC Creatorヘルプ 

 

ほとんどの IDE で効果的に作業できます。「Target IDEs」パネルでご使用される IDE がサポートされていない場合

でも、PSoC Creator は引き続き使用できます。コードの生成後、ご使用の IDE のプロジェクトに必要なファイルを

直接追加してください。AN219434 – PSoC 6 MCU Importing Generated into an IDE は、生成されたコードを別の

IDEに手動でインポートするための詳細な手順を示します。 

http://www.cypress.com/
http://www.cypress.com/an219434
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2.4 RTOSサポート 

PDL には PSoC 6 MCU 開発用の RTOS サポートが含まれています。FreeRTOS ソースコードは PDL に完全に統合

され、組み込まれています。PSoC Creator RTOS インポートオプションを使用して、FreeRTOS ソフトウェアパッ

ケージをプロジェクトにインポートできます。図 6 に示すように、Project > Build Settings メニューに移動し、

Peripheral Driver Library > FreeRTOSの Software package importsオプションから FreeRTOSを選択します。 

図 6. PSoC Creatorのプロジェクトへの FreeRTOSのインポート 

 

優先される RTOS がある場合は、そのコードを PDL と統合する方法の例として提供されているリソースを使用して

ください。 

2.5 デバッギング 

CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit には KitProg2 オンボードプログラマー／デバッガが含まれています。

Cortex Microcontroller Software Interface Standard-Debug Access Port (CMSIS-DAP) とカスタム動作モード、および

KitProg2接続をサポートします。これにより、PSoC 6 MCU Pioneer Kitのデバッグが非常に柔軟になります。詳細

については、KitProg2ユーザーガイドを参照してください。 

PSoC Creatorは、一度に 1つの CPU (CM4または CM0+) のデバッグをサポートします。一部のサードパーティ IDE

は、マルチ CPUデバッグをサポートしています。PSoC Creatorを使用した PSoCデバイスのデバッグの詳細につい

ては、PSoC Creatorヘルプを参照してください。 

2.6 CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit 

CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kitは、PSoC 63BLファミリのデバイスをサポートするサイプレスの BLE

開発キットです。詳細については、サイプレス IoT開発ツールの CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kitを参照

してください。 

2.7 CySmartホスト エミュレーション ツールとモバイル アプリケーション 

CySmartホスト エミュレーション ツールは、PSoC 6 BLE Pioneer Kitの BLEドングルを使用して BLEセントラル 

デバイスをエミュレートする Windows アプリケーションです。詳細は、Appendix D の CySmart ホストエミュレー

ションツールを参照してください。同様の機能は、iOSおよび Androidデバイスの CySmartモバイルアプリケーショ

ンで利用できます。このツールは、BLEアプリケーションのテストに非常に役立ちます。  

http://www.cypress.com/
http://www.cypress.com/documentation/development-kitsboards/kitprog2-user-guide
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3 デバイスの特長 

図 7に示すように、PSoC 6 BLEデバイスには豊富な機能セットがあります。主な機能の一覧は以下のとおりです。

詳細はデバイスのデータシート、テクニカル リファレンス マニュアル (TRM)、および関連アプリケーション ノート

とサンプル コードを参照してください。 

図 7. PSoC 6 MCUと BLE接続のブロックダイヤグラム 

 

▪ 32ビットデュアル CPU MCUサブシステム 

 単精度浮動小数点ユニットを備えた 150MHz CM4 CPU 

 100MHz CM0+ CPU 

 最大 1MBのユーザーフラッシュ、EEPROMエミュレーション用の追加 32KBと監視用 32KB付き 

 最大 288KBの SRAM、32KBの保持境界でディープスリープの保持粒度を選択可能 

 ハードウェアでサポートされるプロセッサ間の通信 

 ハードウェアアクセラレーションと真の乱数ジェネレーター機能をサポートする暗号化アクセラレーター 

 2つの 32チャネル DMAコントローラー 

 eFUSE: ワンタイムプログラマブルビット 

 ハードウェア ハッシュ ベース認証を採用する割込み無しのセキュア ブート 

▪ I/Oサブシステム 

 アナログ、デジタル、CapSense、またはセグメント LCD機能に使用できる最大 78個の GPIO 

 プログラム可能な駆動モード、駆動強度およびスルー レート 
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 ブール演算が実行できるスマート I/Oを備えた 2つのポート 

▪ プログラマブル アナログ ブロック 

 プログラマブル ゲイン アンプ (PGA)、コンパレータまたはフィルターに設定可能な 6MHz ゲイン帯域幅 

(GBW) を持つ 2個のオペアンプ 

 ディープスリープモードとハイバネートモードで動作する、消費電流が 300nA 未満の 2つの低消費電力コン

パレータ 

 16チャネル シーケンサを備えた 1個の 12ビット 1Msps SAR ADC 

 1個の 12ビット電圧モード DAC 

▪ SmartSense™自動チューニングを備えた CapSense 

 CapSenseシグマデルタ (CSD) および CapSense送信/受信 (CSX) をサポート 

 クラス最高の SNR、耐液性、および近接センシングを提供 

▪ プログラマブル デジタル ブロック、通信インターフェース 

 カスタムデジタルペリフェラル用の 12個の UDB 

 16 ビット／32 ビットタイマー、カウンター、PWM、または直交デコーダーとして構成可能な 32 個の

TCPWMブロック 

 I2Cマスターまたはスレーブ、SPIマスターまたはスレーブ、または UARTとして構成可能な 9つの SCB 

 1つの I2Sインターフェースと 2つの PDMチャネルを備えたオーディオサブシステム 

 外部クアッド SPI フラッシュ メモリからの直接実行 (execute-in-place) とオンザフライの暗号化および復号

化をサポートする SMIFインターフェース 

▪ Bluetooth Low Energy 4.2準拠の Bluetooth接続機能 

 集積バランを備えた 2.4GHz BLE無線通信 

 Bluetooth 4.2準拠のコントローラーとホストを実装 

 リンク層エンジンはマスター／スレーブ モードと最大 4つの同時接続をサポート 

 2Mbps LEデータ速度をサポート 

▪ 動作電圧範囲、電源ドメイン、低消費電力モード 

 デバイスの動作電圧範囲: 1.71V～3.6V 

 ユーザー選択可能なコア ロジック動作 (1.1Vまたは 0.9V) 

 複数のオンチップ レギュレータ: 低ドロップ アウト (アクティブ、ディープ スリープ モード用 LDO)、シン

グル入力マルチ出力 (SIMO) 降圧変換器 

 細かい電力管理用のアクティブ、低消費電力アクティブ、スリープ、低消費電力スリープ、ディープ スリー

プ、およびハイバネートのモード 

 BLE リンクが動作するディープ スリープ モード: 3.3V かつ 64KB の SRAM 保持が有効な場合、Typ 電流は
4.5μA 

 組込み RTC、電源管理集積回路 (PMIC) 制御、および制限つき SRAMバックアップを備えた「常時オン」の

バックアップ電源ドメイン 

http://www.cypress.com/
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4 開発セットアップ 

図 8に、PSoC 6 BLEデバイスを用いて BLEペリフェラル設計を評価するために必要なハードウェアとソフトウェア 

ツールを示します。一般な使用事例では、PSoC 6 BLE Pioneer Kit (図 8の青色の基板) は、CySmart iOS／Android

アプリまたは CySmartホスト エミュレーション ツールなどのセントラル デバイスと通信できるペリフェラルとして

設定されます。CySmartホストエミュレーションツールの操作には、BLEドングル (図8の黒色の基板) も必要です。

PSoC 6 BLE Pioneer Kitはドングルを含みます。 

図 8. BLE機能的セットアップ 
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図 9 に示すように、BLE ドングルは、Windows CySmart ホストエミュレーションツールで動作するように事前にプ

ログラムされています。PSoC 6 BLE Pioneer Kitは、BLE設計をプログラムまたはデバッグするためにPSoC Creator

と併用する基板搭載 USB プログラマを備えています。BLE Pioneer Kit は USB インターフェースで電源供給されま

す。BLEドングルと BLE Pioneer Kitの両方を、開発とテストのために共通のホスト PCに同時に接続できます。 

図 9. BLE開発セットアップ 
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5 初めての BLE搭載の PSoC 6 MCU設計 

ここでは、PSoC 6 BLE Pioneer Kit のシンプルな設計をするための順を追った手順を提供します。ファインド ミー 

プロファイル (Find Me Profile; FMP) と呼ばれるシンプルな Bluetooth SIG定義標準プロファイルはこの設計で実装

されます。 

PSoC 6 BLE Pioneer Kitは、BLEベース アプリケーションの設計を簡素化および合理化するためのものですが、BLE

を使用しないアプリケーションを開発する際にも、この設定を使用できます。 

5.1 インストラクションについて 

これらのインストラクションはいくつかのセクションにグループ化されています。各セクションは、アプリケーショ

ン開発ワークフローのフェーズに当てられています。主なセクションは以下のとおりです。 

▪ パート 1: 最初からプロジェクトを新規に作成 

▪ パート 2: 設計の実装  

▪ パート 3: ソース コードの生成 

▪ パート 4: ファームウェアの記述 

▪ パート 5: プロジェクトのビルド、デバイスのプログラミング 

▪ パート 6: デザインをテストする 

これらのインストラクションでは、特定のサンプル コードを使用する必要があります。しかし、サンプル コードを

使用する範囲は、インストラクションに従うパスによって異なります。 

以下に、インストラクションに従った 3つのパスを定義します。 

パス 最初からの作業 

サンプル コードを参考とする 

サンプル コードの使用 

PSoC Creatorまたは BLEに詳しくない 

サンプル コードを使用 

PSoC Creatorと BLEに精通している 

対象 PSoC Creatorおよび BLEを理解す

るために実践体験を学びたい人 

ツールや技術を初めて使い、それがどのよう

に動作するかを見たい人 

ツールと技術に精通しており、それが

PSoC 6プラットフォーム上でどのよう

に動作するかを見たい人 

各パスで行う必要があることは、インストラクションの各パートの始めに明確に定義されています。 

最初から始め、本アプリケーションノートに記載されているすべて手順に従う場合は、サンプル コードを参考にし

てください。最初から作業するパスでは、PSoC Creatorの設計プロセスと BLEの動作方法について最も多くの知識

を取得できますが、一番時間がかかります。これは最も時間がかかります。 

サンプル コードを直接使用することもできます。サンプル コードは、すべてのファームウェアが書かれた完成済み

の設計内容です。サンプル コードでそのインストラクションがどのように実装されているかを確認できます。これ

は、PSoC Creator に精通しており、BLE コンポーネントがどのように構成されるかを見たい人には特に役立つアプ

ローチです。サンプル コードを直接使用する場合、手順の一部を飛ばせます。 

いかなる場合でも、「設計にあたって」および「設計について」をお読みください。 

5.2 設計にあたって 

ホスト コンピュータには以下のものがインストールされていることをご確認ください。 

▪ PSoC Creator 4.2 

▪ PDL v3.0.1 

▪ CySmartホストエミュレーションツールまたは CySmart iOS／Androidアプリ 

▪ CE217236 – このアプリケーションノートで使用されるサンプル コードと 

▪ サンプル コードが実行されるための CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit 

http://www.cypress.com/
https://www.bluetooth.org/docman/handlers/downloaddoc.ashx?doc_id=239389
https://www.bluetooth.org/docman/handlers/downloaddoc.ashx?doc_id=239389
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
http://www.cypress.com/documentation/software-and-drivers/peripheral-driver-library-pdl
http://www.cypress.com/go/cysmart
https://play.google.com/store/apps/details?id=com.cypress.cysmart&hl=en
http://www.cypress.com/CE212736
http://www.cypress.com/go/cy8ckit-062-ble
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上記のリンクをクリックしてサイプレス ウェブサイトからサンプル コードをダウンロードできます。あるいは、

PSoC Creatorで File > Code Exampleコマンドも使用できます。Device Familyを PSoC 63に設定します。次に、

Filter byオプションを Find Meに設定します。CE212736_PSoC6BLE_FindMeサンプル コードが表示されます。サ

ンプル コードを選択し、サンプルの横にあるダウンロードアイコンをクリックしてダウンロードします。インスト

ールが完了したら、Create Projectをクリックし、画面の指示に従います。 

この設計は、CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit用に開発されました。他のハードウェアを使用したい場合、

インストラクションを必要に応じて適応させてください。 

5.3 設計について 

本設計は、即時アラートサービス (Immediate Alert Service; IAS) で構成されるターゲットロールに BLE ファインド 

ミー プロファイル (FMP) を実装します。FMPおよび IASは、Bluetooth SIGによって定義された BLE標準プロファ

イルおよびサービスです。図 10 に示すように、ファインド ミー ロケーターによってトリガされるアラート レベル

は BLE Pioneer Kit上の LEDの状態を変化させることで示します。その他、2つのステータス LEDが BLEインター

フェースの状態を示します。さらに、ターミナル ウィンドウにデバッグメッセージを出力するオプションの UART

コンポーネントもあります。 

図 10. 初めての PSoC 6 BLE設計 

(CySmart PC/Mobile App)

IAS GATT Client

Write Alert Level

(CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit)

IAS GATT Server

Service

IAS

Characteristic

Alert Level

Immediate Alert Service
Mild Alert (0x01)

LED OFF

LED BLINK

LED ONMap to PSoC Creator 

Schematic
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5.4 パート 1: 最初からプロジェクトを新規に作成 

ここでは、最初からプロジェクト ファイルを作成するプロセスを、順を追って説明します。 

パス 
最初からの作業 

サンプル コードを参考とする 

サンプル コードを使用 

PSoC Creatorまたは BLEに詳しくない 

サンプル コードを使用 

PSoC Creatorと BLEに精通している 

アクション すべてのステップを行う 
ステップ 1を行う 

残りのステップを読む 
ステップ 1を行ってから、パート 2へ進む 

 

注: これらの手順では、ユーザーが PSoC Creator 4.2以降を利用していることを前提にします。開発プロセス全体は

PSoC Creatorの後続バージョンでも同じですが、ユーザー インターフェースは変更されることがあります。 

PSoC Creatorを起動して始めましょう。 

1. PSoC Creatorが PDLを利用できるようにする 

これはインストール時に自動的に正しく設定されますが、誤ってセットアップされると何も実行できません。こ

のステップのヘルプをお求めの場合は、図 11を参照してください。 

A. メニュー項目の Tool > Optionsを選択します。 

B. Project Managementパネルで、PDL v3 (PSoC 6 Devices) locationフィールドのパスを確認してください。  

C. パスが正しいことを確かめてください。正しくない場合は、Browse ボタンをクリックして、PDL がインス

トールされたディレクトリを探します。デフォルトの場所は C:\Program Files (x86)\Cypress\PDL\3.0.1です。 

図 11. ペリフェラル ドライバー ライブラリ (PDL) のインストール場所 

A

B

 

オプション: パート 2：設計の実装へ進みます。 
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2. PSoC Creatorプロジェクトを新規作成 

図 12に示すように File > New > Projectを選択します。Create Projectウィンドウが表示されます。 

図 12. 新しい PSoC Creatorプロジェクトの作成 

 

注: サンプル コードを使用している場合は、図 13 のように File > Open > Project/Workspace を選択します。

Openウィンドウが表われます。サンプル コード ワークスペースの場所を指して、ワークスペースを開きます。 

図 13. 既存のサンプル コード ワークスペースを開く 

 

3. PSoC 6 BLEをターゲット デバイスに選択 

PSoC Creatorは、自動的にさまざまなプロジェクトオプションを特定の開発キットやターゲットデバイスに設定

するため、開発時間を短縮できます。このステップのヘルプについては、図 14を参照してください。 

A. Target Deviceを選択します。 

B. ファミリドロップダウンリストから、PSoC 6を選択します。 

C. デバイスのドロップダウンメニューから、PSoC 63をリストします。 

D. Nextをクリックします。プロジェクトテンプレートの選択パネルが表示されます。 

PSoC Creatorは、BLE搭載の PSoC 6 MCUファミリには CY8C6347BZI-BLD53をデフォルトデバイスとして使

用します。このデバイスは、CY8CKIT-062-BLE PSoC 6 BLE Connectivity Pioneer Kitに搭載されています。 

PSoC 6 BLEに基づくカスタムハードウェアまたは別の PSoC 6 BLE製品番号を使用する場合、これは、Target 

Deviceの中で Launch Device Selectorオプションを選んで適切な製品番号を選択する場所です。 

図 14. ターゲット デバイスの選択 

A
B C

D

 

http://www.cypress.com/


 

PSoC Creatorでの PSoC 6 BLE入門 
 

www.cypress.com Document Number: 002-23474 Rev. *A 19 

4. プロジェクト テンプレートを選択 

A. Empty schematicを選択します。 

B. Nextをクリックします。 

図 15. プロジェクト テンプレートを選択 

A

B

 

5. 対象の IDEを選択 

プロジェクトからコードをエクスポートする場合、対象の IDE を選択してください。デフォルトでは、すべての

エクスポート オプションは無効になっています。状況が変わる場合、後でこの設定を変更できます。 

Nextをクリックして、デフォルト設定を受け入れます。 

図 16. 対象の IDEを選択 (すべては無効) 

  

6. プロジェクトを作成 

このステップでは、ワークプレースの名前と保存先およびプロジェクトの名前をセットします。このステップの

ヘルプについては、図 17を参照してください。1つのワークスペースに 1つ以上のプロジェクトを格納できます。 

A. Workspace nameをセットします。  

B. ワークスペースの Locationを指定します。 

C. Project nameをセットします。プロジェクト名とワークスペース名は同じでも違っても構いません。 
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D. Finishをクリックします。 

図 17. プロジェクトの命名および保存先 

A

B

C

D

 

 

このように、PSoC Creatorプロジェクトの新規作成ができました。 
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5.5 パート 2: 設計の実装 

プロジェクト ファイルを作成したので、このパートでは PSoC Creatorコンポーネントを使用してハードウェア設計

を実装します。サンプル コードを直接使用する場合、それはすでに完成した設計です。この作業で選択したパスに

基づいて推奨されるアクションを行います。 

パス 
最初からの作業 

サンプル コードを参考とする 

サンプル コードを使用 

PSoC Creatorまたは BLEに詳しくない 

サンプル コードを使用 

PSoC Creatorと BLEに精通している 

アクション すべてのステップを行う すべてのステップを読んで理解 
この部分を飛ばすことができます。  

パート 3: ソース コードの生成へ進む 

 

デザインを実装する前に、PSoC Creatorインターフェースのクイックツアーが順を追って行われます。 

図 18に、空の設計回路図を表示する PSoC Creatorアプリケーションを示します。 

このプロジェクトは基本的なファイル セットを格納するプロジェクト フォルダを含みます。これらのファイルは左

側の Workspace Explorer ペインに表示されます。デフォルトでは、プロジェクト回路図が開きます。これは

TopDesign.cysch ファイルです。エクスプローラ ペインでファイル名をダブルクリックすると、回路図が開かれま

す。新規プロジェクトでは、回路図は空です。サンプル コードを使用する場合、これはファインド ミーBLE アプリ

ケーションの回路図となります。 

Component Catalogがウィンドウの左側にあります。これは、View > Component Catalogメニュー アイテムで開

けます。Search for…テキスト ボックスにコンポーネント名を入力してエンター キーを押すことで特定のコンポー

ネントを検索できます。図 18を参照してください。 

図 18. 回路図およびコンポーネント カタログ 

Workspace 

Explorer
Component 

Catalog

Component 

Search Box
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1. デザインにコンポーネントを配置 

このデザインで、BLEコンポーネント、3つのデジタル出力ピン、UART、ウォッチドッグタイマー、および割込

みなど、いくつかのコンポーネントを使用します。このステップでは、それらをデザインに追加します。後続ス

テップで、それらを設定します。図 19に結果を示します。 

A. Component Catalogで、Communicationsグループを展開し、BLEコンポーネントを回路図にドラッグ＆

ドロップします。コンポーネントは、どこに配置しても構いません。あるいは、Component Catalog検索ボ

ックスに「BLE」を入力しても BLEコンポーネントを検索できます。 

B. また Communications グループで UARTを展開し、UART (SCB) コンポーネントをデザインにドラッグし

ます。 

C. Ports and Pinsグループを展開し、Digital Output Pinをデザインにドラッグします。これをさらに 2回繰

返し、合計 3つのピンを作成します。 

D. Systemグループを展開し、InterruptコンポーネントとMCWDTコンポーネントをデザインにドラッグしま

す。 

図 19. デザインにコンポーネントを配置 

Drag and 

Drop 

Components

 

PSoC Creatorは各コンポーネントにデフォルトの名前とプロパティを与えます。特定のデザインによっては、デ

フォルト値はふさわしくない場合があります。後続ステップで、名前およびプロパティの一部を修正します。 
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2. 3個の LEDピンを設定 

1つのピンがアラートステータス LEDを駆動します。残りの 2個は、BLEアドバタイズおよび切断状態指示 LED

を駆動します。BLE Pioneer Kitでは LEDはアクティブ LOWです。すなわち、ピンを HIGHに駆動すると LEDは

消灯し、ピンを LOWに駆動すると LEDは点灯します。 

3 個のピンは名前を除き、同じように設定されます。これらの指示を 3 回繰り返します (ピンごとに 1 回)。図 20

はコンフィギュレーションを示します。 

回路図に配置されたコンポーネントをダブルクリックして、設定ダイアログを開き、以下の手順を実行します。 

A. 各ピンのコンポーネント インスタンス名を、Alert_LED、Advertising_LED および Disconnect_LED に変

更します。 

B. 各ピンに対し、HW connectionの選択を解除します。ファームウェアはピンを駆動します。 

C. 各ピンに対し、Initial drive state を High (1) に設定します。したがって、LED はデフォルトでオフになり

ます。 

図 20. 出力ピンコンポーネントの設定 

A

B

C

Click to view 

Component datasheet

Click to view PDL 

Documentation

 
必ず 3個のピンをすべて設定してください。 

ヒント: 各コンポーネントには、設定ウィンドウからアクセスできる対応データシートがあります。コンポーネント 

データシートは、コンポーネントの設定、アプリケーション プログラミング インターフェース (API) および電気的

仕様の詳細情報を提供します。 

ヒント：コンポーネントを右クリックして Open PDL Documentation…リンクをクリックすると、コンポーネント

に関連 PDLドライバーの APIリファレンスドキュメントを開けます。図 20を参照してください。 

ヒント：ピンに対して External terminal を有効にすることで、外部の「オフチップ」コンポーネントをデザインに

追加できます。回路図上の外部コンポーネントは、説明のためのみ含まれ、生成されたコードには影響を与えません。

オフチップコンポーネントは任意ですが、ハードウェア設計チームがデザインの仕組みを理解する際に役立ちます。

また、記述用のテキストボックスを追加することもできます。図 21に、アラート LEDのデザインを拡張する方法を

示します。この場合、オフチップコンポーネントは Instance_Name_Visible の選択を外して設定します。抵抗は、

Valueフィールドを空白にして設定します。電源端子は、Supply_Nameが P6_VDDにセットして設定します。 

図 21. 外部コンポーネント付きの出力ピン 
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3. ハイバネート ウェイクアップピンを設定 

Pioneer Kit上の SW2スイッチは、ハイバネート ウェイクアップピンの 1つである P0[4]に接続されており、押さ

れるとポートピンを LOWにします。このピンをハイバネート ウェイクアップ スイッチに設定するには、抵抗プ

ルアップ ピンに設定する必要があります。 

図 22に設定を示します。回路図に配置されたコンポーネントをダブルクリックして設定ダイアログを開き、以下

を行います。 

A. コンポーネント インスタンス名を Hibernate_Wakeup_SWに変更します。 

B. HW connection の選択を外します。アプリケーション ファームウェアは、このピンを駆動しませんが、ピ

ンはハイバネート システムに固定接続されます。ファームウェアでは、ウェイクアップ信号はアクティブ

LOWに設定してされます。 

C. Drive modeを Resistive Pull Up、Initial drive stateを High (1) にセットします。これにより、HIGHから

LOWへの遷移を検出してハイバネート モードから復帰するようデバイスを設定します。 

図 22. 入力ピン コンポーネントを設定 

A

B

C

 

4. UARTコンポーネントを設定 

回路図に配置されたコンポーネントをダブルクリックして、設定ウィンドウを開きます。このコンポーネントを

使用して 115200bpsのボーレートでターミナル ウィンドウにデバッグ メッセージを表示します。これは BLE機

能には関係しません。 

A. コンポーネント インスタンスの Nameを「UART_DEBUG」に変更します。 

B. OK をクリックします。 

このデザインで、他のすべての設定にはデフォルト値を使用します。 

図 23. SCBベースの UARTコンポーネントを設定 

A

B

` 
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5. 一般の BLEオプションを設定 

回路図に配置された BLE コンポーネントをダブルクリックして設定ウィンドウを開きます。図 24 に示すように

General プロパティをセットします。このアプリケーションで、コンポーネント名およびスタック操作を除き、

デフォルトの一般のプロパティを使用します。 

A. Nameを「BLE」に変更します。 

B. Complete BLE Protocolが選択されていることを確認します。 

C. Maximum number of BLE connections を 1 に変更します。このように、BLEスタックを適切に設定しま

す。 

D. Peripheral が GAP role に選択されていることを確認します。このように、BLEペリフェラルデバイスとし

て機能し、セントラルデバイスの要求に応答するようデバイスを設定します。 

E. CPU coreを Dual core (Controller on CM0+, Host and Profiles on CM4) オプションに選択します。この

ように、両方のコアで動作するようBLEスタックを分割します。CM0+コアはスタックの BLEコントローラ

ー部分を実行し、BLE 接続の維持を担当します。BLE ホストは CM4 コア上で動作し、アプリケーションレ

ベルのタスクを実行します。このデュアル CPU の主な利点は、保留中の BLE 関連のタスクがないときには、

CM4コアがディープスリープ低消費電力モードに移行できることです。 

図 24. BLEコンポーネントの一般設定 

 

A

B

C

E

D

 

6. Generic Attribute (GATT) 設定を指定 

このステップでは、図 25に示すように BLEプロファイルを設定します。 

A. GATT Settingsタブをクリックして GATTオプションを表示します。 

B. Add Profileドロップダウンメニューをクリックします。 

C. Find Me > Find Me Target (GATT Server) オプションを選択します。このように、GAPペリフェラル ロー

ル プロファイルをセットします。メニューが閉じると、図 26に示すように「Immediate Alert」という新し

いサービスが現れることにご注意ください。 
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図 25. BLEコンポーネントの GATT設定 
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C
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図 26. BLEコンポーネントの即時アラート サービスを追加 

 

注: このサンプル コードには、デバイスを識別してファームウェアバージョンを読み出すために、GATT設

定に追加される Device Information Service (デバイス情報サービス) があります。このサービスは、

Immediate Alertが動作する際には必要ありません。 
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7. Generic Access Profile (GAP) の一般設定を指定 

GAP 設定のために、一連のパネルがあります。左メニューでは、すべてのパネルへアクセスできます。図 27 を

参照してください。 

A. GAP Setting タブをクリックして、GAP オプションを表示します。デフォルトでは General パネルが表示

されます。 

B. Device nameとして「Find Me Target」を入力します。 

C. Appearanceを Generic Keyringにセットします。 

他のすべての一般設定はデフォルト値を使用します。これには、デバイスは Silicon generated “Company 

assigned” part of device address を使用します。これにより、ホストデバイスがご使用のデバイスを検出しよ

うとし、それに固有の BLEデバイス アドレスを割り当てる時に現れるデバイス名とタイプを設定します。 

図 27. BLEコンポーネントの GAP一般設定 
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8. GAPアドバタイズメント設定を指定 

このステップのヘルプをお求めの場合は、図 28を参照してください。 

A. 左メニューで Advertisement settingをクリックしてパネルを表示します。 

B. Advertising typeを Connectable undirected advertisingにセットします。 

C. Slow advertising intervalチェックボックスのチェックを外します。 

それ以外では、このアプリケーションはデフォルト値を使用します。30sのアドバタイズ タイムアウトおよび 20

〜30ms の高速アドバタイズ間隔の有限検出モードを使用します。高速アドバタイズにより、迅速に検出し接続

を確立することが可能ですが、RFアドバタイズ パケットが増加するため消費電力が高くなります。 

図 28. BLEコンポーネントの GAPアドバタイズ設定 
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9. GAPアドバタイズメントパケットの設定を指定 

このステップでは、即時アラートサービス (IAS) に対応するようにデバイスを設定します。図 29を参照してくだ

さい。 

A. 左メニューで Advertisement packetをクリックしてパネルを表示します。 

B. Service UUID項目を展開して Immediate Alertを選択します。 

このように、IASが使用可能であることを BLEセントラル デバイスに通知するようデバイスを設定します。項目

を追加すると、アドバタイズ パケットの構造および内蔵が設定パネルの右側に現れます。 

図 29. BLEコンポーネントの GAPアドバタイズ パケット設定 
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10. スキャン応答パケット設定を指定 

このステップでは、スキャン応答パケットの設定を指定します。図 30に結果を示します。値を追加するとスキャ

ン応答パケットの構造および内容が設定パネルの右側に現れることにご注意ください。 

A. 左メニューで Scan response packetをクリックしてパネルを表示します。 

B. Local Name を選択してこの項目を応答パケットに含めます。Complete であるデフォルト設定を OK にし

ます。 

C. TX Power Levelを選択してこの項目をパケットに含めます。  

D. Appearanceを選択してこの項目をパケットに含めます。 

図 30. BLEコンポーネントの GAPスキャン応答パケット 
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11. セキュリティ コンフィギュレーション設定を指定 

このステップでは、デバイスのセキュリティ設定を行います。デバイスは、データ交換用の認証や暗号化、権限

付与が不要なコンフィギュレーションを使用します。図 31を参照してください。 

A. 左メニューで Security configuration 0をクリックしてパネルを表示します。パネルが表示されます。 

B. Security mode が Mode 1、Security level が No Security であることを確認します。そうでない場合、設

定を修正します。 

C. IO capabilitiesを No Input No Outputにセットします。 

D. Bonding requirementを No Bondingにセットします。 

E. OKをクリックして、BLEコンポーネントの設定を完了します。 

図 31. BLEコンポーネントの GAPセキュリティ設定 

C

B

D

E
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このデザインでは、LDCAP Settings、Link Layer Settingsおよび Advancedタブのすべてのオプションを含む

他のすべての設定はデフォルト値を使用します。 

各設定の重要性を理解できるように、コンポーネントデータシートを参照してください。 
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12. 割込みをトリガするように MCWDTコンポーネントを設定 

このステップでは、250msごとに (4Hzで) 割込みをトリガするようマルチカウンター ウォッチドッグ (MCWDT) コ

ンポーネントを設定します。MCWDTのクロックソースは、低周波数クロック (LFCLK) です。LFCLKのソースは、

デフォルトでは内部低速発振器 (ILO) です。このデザインはこの割込みを使用して、MILD アラートが受信されると

アラート LED を 2Hz で点滅させます。図 32 を参照してください。回路図に配置されたコンポーネントをダブルク 

リックし、以下のように設定します。 

A. Nameを「MCWDT」に変更します。 

B. Counter0 で、Match の値を 7999、Mode を Interrupt に変更します。Clear on Match フィールドを Clear 

on matchに変更します。 

C. OKをクリックして、MCWDTコンポーネントの設定を完了します。 

図 32. MCWDT_PDLの設定 

A
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13. ディープスリープモードで CM4 CPUをウェイクアップするよう割込みコンポーネントを設定 

このステップでは、CM4 CPU をウェイクアップするように SysInt コンポーネントを設定します。図 33 を参照して

ください。 

A. Nameを「MCWDT_isr」に変更します。 

B. 割込みの Deep Sleep Capableオプションを選択します。 

C. OKをクリックし、SysIntコンポーネントの設定を完了します。 

図 33. SysInt_PDLの設定 
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B
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最終ステップとして、MCWDT コンポーネントの割込み出力を MCWDT_isr コンポーネントの入力に接続します。

このように、ウォッチドッグ割込みを CPUに接続します (この割込みの CM4 CPUでの選択は後続ステップでシ

ステム割込み設定でセットされます)。回路図で、ワイヤー ツール ボタンを使用するか、または「W」キーを押

して、コンポーネントの配線を開始します。 

図 34. MCWDTペリフェラル割込みを CM4 CPUに接続 
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14. 各ピン コンポーネントの物理ピンを設定 

このステップは、デザインを完了するための最後のタスクです。各コンポーネントをデバイス上の必要な物理ピ

ンに関連付ける必要があります。使用するピンは基板設計によって決まります。この情報はキット回路図からご

利用できます。図 35にこのステップの最終結果を示します。  

ピンを設定するために、対応するフィールドにポート番号やピン番号を入力するか、またはドロップダウン メニ

ューでポートやピンを選択します。一般的には、ポート番号は使用する特定のパッケージに依存しないため、ピ

ン番号の代わりに使用されています。 

A. ピン セレクタを開きます。 

Workspace Explorer ペインで、Design Wide Resourcesの下にある Pins 項目をダブルクリックします。 

デバイスのピン セレクタが表示されます。 

B. 表 1に示すように各ピンを設定します。 

表 11. CY8CKIT-062-BLEにおける物理ピン割当て 

ピン コンポーネント名 ポート名 

UART_DEBUG：rx P5 [0] 

UART_DEBUG：tx P5 [1] 

Advertising_LED P1 [1] 

Alert_LED P11 [1] 

Disconnect_LED P0 [3] 

Hibernate_Wakeup_SW P0 [4] 

 

図 35. ピン割当て 
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15. システム クロックの設定 

このデザインでは、高周波数クロックの設定にデフォルト値を使用します。このデザイン用に高周波数クロック

を修正しませんが、PSoC Creatorがそれらをどのように管理するかを理解することが必要です。自分の基板をご

使用の場合は、それらを修正する必要があることがあります。 

このステップでは、基板上の正確な時計用水晶発振器 (WCO) になるように低周波数クロックソースを設定しま

す。このクロックは、タイミングの目的に BLEサブシステム (BLESS) によって使用されます。 

A. Workspace Explorerペインで、Design Wide Resources (CE212736.cydwr) の下にある Clocks項目をダ

ブルクリックします。クロック一覧が表示されます。 

B. Edit Clock…をクリックして、Configure System Clocksダイアログが表示します。 

ここにはクロック ツリーが表示され、必要に応じてクロックを修正できます。Source Clocks、FLL/PLL、

High Frequency Clocks、および Miscellaneous Clocksの異なるクロック タイプ タブがあることにご注

意ください。 

C. Source Clocksタブをクリックします。 

D. AltHF BLE ECOブロックでチェックボックスを選択して BLE ECOを有効にします。パラメーターは基板搭

載の水晶と一致する必要があります。CY8CKIT-062-BLE キットでは、ECO Frequency が 32 MHz、

Accuracyが± 50 ppmです。基板上に負荷容量がないため、9.900の指定された最小の Load cap (pF) を使

用します。ECO水晶発振器の迅速な起動のために、Startup Time (µs) が 785 µsであることを確認します。 

E. WCO (32.768 kHz) ブロックでチェックボックスを選択してWCOクロックを有効にします。 

F. Miscellaneous Clocksタブをクリックします。 

G. WCOを LFClkのソースに選択します。 

H. WCOを BakClkのソースに選択します。図 36を参照してください。 

図 36. クロックの設定 
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16. システム割込みの設定 

このステップでは、システムの割込みを設定します。図 37を参照してください。 

A. Workspace Explorerペインで、Design Wide Resourcesの下にある Interrupts 項目をダブルクリックし

ます。割込み一覧が表示されます。 

B. CM0+ CPU で BLE_bless_isr が有効にされ、優先度が 1、ベクトルが 3 にセットされていることを確認し

ます。このように、BLE コントローラーの割込みが CM0+によって最優先で確実に処理され、またディープ

スリープモードにおいて確実にも処理されるようにします。 

C. CM4ではMCWDT_isrを有効にします。 

D. 両方のコアで UART_DEBUG_SCB_IRQ割込みを無効にします。 

対応するチェックボックスのチェックを外します。このデザインでは、UART_DEBUGコンポーネントに関

連する割込みを使用しないため、その割込みは無視できます。 

「パート 3: ソース コードの生成」でコードを生成すると、割込み番号が PSoC Creatorによって自動的に生成さ

れます。 

図 37. 割込みの設定 
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開発プロセスの次の段階はコードの生成です。 

注: この演習では、対象の IDE へのエクスポートの詳細を説明しません。ただし、対象の IDE を使用する場合は、 

コードの生成前に、正しい対象の IDE が選択されていることを確認するワークフロー内の要点です。「他の IDE の

サポート」を参照してください。 
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5.6 パート 3: ソース コードの生成 

PSoC Creatorはデザインに基づいてソース コードを生成します。推奨するワークフローとしては、ファームウェア

を書く前にコードを生成します。PSoC Creator は、ファームウェアで使用されるマクロ、定数および API 呼び出し

を自動的に作成します。 

このパートは非常に簡単で、パスはどなたでも同じです。 

パス 
最初からの作業 

サンプル コードを参考とする 

サンプル コードを使用 

PSoC Creatorまたは BLEに詳しくない 

サンプル コードを使用 

PSoC Creatorと BLEに精通している 

アクション 唯一のステップを行う 唯一のステップを行う 唯一のステップを行う 

 

1. アプリケーションを生成 

Build > Generate Applicationを選択します。PSoC Creatorはデザインに基づいてソース コードを生成し、ファ

イルを Generated_Source フォルダに保存します。図 38 を参照してください。PSoC Creator は、発生する可能

性があるエラーや問題について警告します。最初から作業を行い、かつエラーが発生した場合、「パート 2: 設計

の実装」での設定手順を再検討して、それらが正しく行われたことを確認してください。 

図 38. アプリケーションの生成 
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バックグラウンド: PSoC 6 BLE はデュアル CPU プラットフォームです。ファームウェアは、CM4 または CM0+の

いずれかで実行するようにターゲット設定できます。これは、ファイル プロパティへアクセスすることでソース  

ファイル レベルで設定します。ソースファイルを右クリックして、Propertiesを選択します。図 39に、Properties

ダイアログ ウィンドウを示します。このサンプル コードは、CM4コアを対象とします。 

デフォルトでは、main_cm0p.c ファイルは CM0+を、main_cm4.c ファイルは CM4 を対象とします。その他のファ

イルに対しては、プロパティを修正する必要はありません。それらは既にサンプル コードで設定されています。 

通常、CM0+向けのファイルは CM0p フォルダに、CM4 向けのファイルは CM4 フォルダに配置されていますが、プ

ロパティも適切に設定する必要があります。すなわち、ファイルを正しいフォルダに保存するだけで特定のコア上で

実行するというわけではありません。 

図 39. ソース Cファイル用のターゲットプロセッサを設定 
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5.7 パート 4: ファームウェアの記述 

開発プロセスのこの時点では、プロジェクトの作成、ハードウェア設計の実装およびコードの生成が行われました。

このパートでは、アプリケーションに BLE機能を実装するファームウェアを検討します。 

ファームウェアは BLE 標準のプロファイル アプリケーションを実装するために、以下を含むいくつかのタスクを遂

行しなければなりません。 

▪ システム初期化を実行 

▪ BLEスタック イベント ハンドラを実装 

▪ BLEサービス固有イベント ハンドラを実装 

▪ メイン ループを実行 

▪ 低消費電力の性能を実装 (任意) 

このパートの手順では、「パート 2: 設計の実装」で設定したデザイン向けのファームウェアを説明します。コード

の 1つ 1つの行を検討しませんが、重要な機能を実装するコード内の重要な要素を指摘します。 

パス 
最初からの作業 

サンプル コードを参考とする 

サンプル コードを使用 

PSoC Creatorまたは BLEに詳しくない 

サンプル コードを使用 

PSoC Creatorと BLEに精通している 

アクション すべてのステップを行う 
ステップ 1を飛ばす。 

残りのステップを行う 

この部分を飛ばすことができる。 

「パート 5: プロジェクトのビルド、デ

バイスのプログラミング」へ進む 

 

サンプル コードにはすべての必要なコードがあります。最初から作業を行う場合、ステップ 1 でサンプル コードの

プロジェクトからソース ファイルをコピーします。サンプル コードを使用する場合、それらのファイルは既にプロ

ジェクトに含まれているため、ステップ 1を飛ばしても構いません。 

1. プロジェクトにファイルを追加 

サンプル コードを使用する場合、このステップを飛ばしても構いません。サンプル コードには既に必要なソース 

ファイルがあります。 

最初から作業を行う場合、必要なソース コード ファイルはご使用のプロジェクトにありません。 

A. サンプル コード用のソースファイルを格納するCE212736.cydsnフォルダを探します。このフォルダは、以

前ダウンロードしたサンプル コード ワークスペース アーカイブにあります。 

B. これらのファイルを CE212736.cydsnフォルダからプロジェクトの.cydsnフォルダにコピーします。既存の

ファイルを置き換えます。 

▪ BLEFindMe.h 

▪ debug.h 

▪ LED.h 

▪ BLEFindMe.c 

▪ debug.c 

▪ main_cm0p.c 

▪ main_cm4.c 

C. これらのファイルをプロジェクトに追加します。このためには、ファイルを Windows フォルダから

Workspace Explorerにドラッグし、ワークスペース内の CM4フォルダの場所にドロップします。図 40を参

照してください。 

▪ BLEFindMe.h 

▪ debug.h 

▪ LED.h 

▪ BLEFindMe.c 

▪ debug.c  
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図 40. プロジェクトにファイルを追加 

Windows Workspace Explorer

 

プロジェクトには、デフォルトで main_cm0p.c と main_cm4.c ファイルがあるため、それらを追加する必要はあ

りません。プロジェクトが新しいバージョンを使用できるように単に projectフォルダでそれらを置き換えます。 

2. システムを初期化 

残りのステップで、main_cm0p.c および main_cm4.c ファイル内のコードを検討します。明確にするために、 

プログラムコードのデバッグ プリント文が削除される場合があります。コードを完全に理解するために、実際の

ソースファイルを参照してください。 

図 41に、システムを初期化するプロセスの手順を示します。PSoC 6 BLEデバイスがリセットされると、ファー

ムウェアはまずシステムの初期化を実行します。このプロセスでは、実行用のCPUコアのセットアップ、グロー

バル割込みおよび設計で使用するコンポーネントを有効にします。初期化プロセスは CPU コア間で分割されま

す。CM0p CPU はリセットを終了し、BLE コントローラー部分の開始を試みます。成功したら、CM0p CPU は

CM4 CPU を有効にします。CM4 CPU は BLE ホストの部分を開始し、アプリケーション側の必要なハンドラ関

数を登録します。 

図 41. システム初期化のフローチャート – CM4 
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main_cm0p.c のコードは、BLE API 呼び出しからの返り値を保持するローカル変数を宣言します。主なタスクは、

BLEコントローラーを有効にし、アプリケーションコードを実行するためのCM4をセットアップすることです。

メインループでは、CM0p CPUはコントローラーで保留中の BLEイベントを処理します。保留中のイベントがな

い時、CM0pはディープスリープモードに入ります。 

int main(void) 

{ 

    cy_en_ble_api_result_t          apiResult; 

    __enable_irq(); /* Enable global interrupts. */  

    /* Unfreeze IO if device is waking up from hibernate */ 

    if(Cy_SysPm_GetIoFreezeStatus()) 

   { 

      Cy_SysPm_IoUnfreeze(); 

   }  

    /* Start the Controller portion of BLE. Host runs on the CM4 */ 

    apiResult = Cy_BLE_Start(NULL); 

    if(apiResult == CY_BLE_SUCCESS) 

{ 

        /* Enable CM4 only if BLE Controller started successfully.  

        *  CY_CORTEX_M4_APPL_ADDR must be updated if CM4 memory layout  

        *  is changed. */ 

        Cy_SysEnableCM4(CY_CORTEX_M4_APPL_ADDR);  

} 

    else 

    { 

        /* Halt CPU */ 

        CY_ASSERT(0u != 0u); 

    } 

for(;;) 

{ 

   /* Place your application code here. */ 

   /* Put CM0p to deep sleep. */ 

   Cy_SysPm_DeepSleep(CY_SYSPM_WAIT_FOR_INTERRUPT); 

 

   /* Cy_Ble_ProcessEvents() allows BLE stack to process 

      pending events */ 

    

   /* The BLE Controller automatically wakes up host if required */ 

   Cy_BLE_ProcessEvents();         

    }  

main_cm4.c のコードは、CM4 が使用する主なコンポーネントを初期化し、BLE アプリケーションプロセスを引

き続き実行します。BleFindMe_Init() ルーチンは、CM4割込みのセットアップを含む、すべてのコンポーネン

トを初期化および起動を行います。主なタスクは BLEホストを有効にすることです。 

アプリケーションプロセスでは、CM4 CPU はホスト上で保留中の BLE イベントを処理します。保留中のイベン

トがない場合、CM4はディープスリープ低消費電力モードに入ります。 
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int main(void) 

{ 

   __enable_irq(); /* Enable global interrupts. */ 

  

   /* Initialize BLE */ 

   BleFindMe_Init(); 

    

   for(;;)  

   {    

     BleFindMe_Process(); 

   } 

} 

3. BLEコンポーネントを起動し、イベントハンドラを登録 

CPU が初期化された後、ファームウェアは BLE コンポーネントを初期化し、その結果、BLE サブシステムが完

全にセットアップされます。BleFindMe_Init()サブルーチンが実行します。主なタスクに集中するために、デ

バッグ プリント文は削除されます。完全なコードを検証するために、ソース ファイルを参照してください。 

BLEコンポーネントの初期化プロセスの一部として、保留中のイベントを通知するために BLEスタックによって

呼び出されるイベント ハンドラ関数を正常に実行する必要があります。BLEコンポーネントの初期化が正常に完

了すると、ファームウェアは IAS固有イベント用の第 2のイベント ハンドラを登録します。 

コードは PDL API関数の呼び出しを使用してアプリケーションを設定します。まず、BLEコンポーネントを起動

します。パラメーターはスタック イベント ハンドラ関数のアドレスです。 

コードはスタックバージョンも取得します。デバッグポートが有効な場合、バージョンはシリアル通信ウィンド

ウに表示されます。 

その後、即時アラートサービス関連のイベントを処理するための IAS イベントハンドラを登録します。最後に、

250msごとに割込みを 1回トリガできるよう MCWDTを設定します。 

void BleFindMe_Init(void) 

{ 

    cy_en_ble_api_result_t          apiResult; 

    cy_stc_ble_stack_lib_version_t  stackVersion;     

     

    /* Configure switch SW2 as hibernate wake up source */ 

    Cy_SysPm_SetHibWakeupSource(CY_SYSPM_HIBPIN1_LOW); 

 

     /* Start BLE component and register generic event handler */ 

    apiResult = Cy_BLE_Start(StackEventHandler); 

     

    apiResult = Cy_BLE_GetStackLibraryVersion(&stackVersion); 

     

    /* Register IAS event handler */ 

    Cy_BLE_IAS_RegisterAttrCallback(IasEventHandler); 

 

    /* Enable 4 Hz free-running MCWDT counter 0*/ 

    /* MCWDT_config structure is defined by the MCWDT_PDL component based on 

       parameters entered in the customizer. */ 

    Cy_MCWDT_Init(MCWDT_HW, &MCWDT_config); 

    Cy_MCWDT_Enable(MCWDT_HW, CY_MCWDT_CTR0, 93 /* 2 LFCLK cycles */); 

    /* Unmask the MCWDT counter 0 peripheral interrupt */ 

    Cy_MCWDT_SetInterruptMask(MCWDT_HW, CY_MCWDT_CTR0); 

  

    /* Configure ISR connected to MCWDT interrupt signal*/ 

    /* MCWDT_isr_cfg structure is defined by the SYSINT_PDL component based on 

       parameters entered in the customizer. */ 

    Cy_SysInt_Init(&MCWDT_isr_cfg, &MCWDT_Interrupt_Handler); 

    /* Clear CM4 NVIC pending interrupt for MCWDT */ 

    NVIC_ClearPendingIRQ(MCWDT_isr_cfg.intrSrc); 
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    /* Enable CM4 NVIC MCWDT interrupt */ 

    NVIC_EnableIRQ(MCWDT_isr_cfg.intrSrc); 

 

} 

4. スタック イベント ハンドラを実装 

BLE コンポーネント内の BLE スタックはイベントを生成します。それらのイベントは BLE スタックイベントハ

ンドラをとおして、アプリケーションファームウェアにステータスおよびデータを提供します。図 42に、特定の

イベントを表す簡素化したフローチャートを示します。 

図 42. BLEスタックイベントハンドラのフローチャート 
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イベント ハンドラはスタックからのいくつかの基本的なイベントを処理する必要があります。このサンプル コー

ドでのファインド ミー ターゲット アプリケーションに対しては、BLEスタック イベント ハンドラは表 2で説明

するイベントを処理しなければなりません。実際のコードは追加のイベントを認識し、それらに応答しますが、

このアプリケーションには必須ではありません。 

表 2. BLEスタック イベント 

BLEスタック イベント名 イベントの説明 イベント ハンドラの応答処理 

CY_BLE_EVT_STACK_ON BLEスタックの初期化が正常に完了した アドバタイズを開始し、アドバタイズ状

態を LEDに反映 

CY_BLE_EVT_GAP_DEVICE_DISCONNECTED ピア デバイスとの BLE接続が切断 アドバタイズを再始動し、アドバタイズ

状態を LEDに反映 

CY_BLE_EVT_GAP_DEVICE_CONNECTED ピア デバイスとの BLE接続が確立 BLE接続状態を LEDに更新 

CY_BLE_EVT_GAPP_ADVERTISEMENT_START_STOP BLEスタックのアドバタイズ開始／停止

イベント 

BLEスタックをシャットダウン 

CY_BLE_EVT_HARDWARE_ERROR BLEハードウェアエラー ハードウェア エラーを反映するように

LED状態を更新し、CPUを停止 

CY_BLE_EVT_STACK_SHUTDOWN_COMPLETE BLEスタックがシャットダウン ハイバネートモードにデバイスを設定

し、ウェイクアップピン上のイベントを

待機 
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以下のプログラムコードは、イベントハンドラが特定のイベントにどのように応答するかを示す 2 つの例です。

完全に理解するために、実際のソースコードを参照してください。 

このプログラムコードで、ハンドラは「アドバタイズの開始／停止」イベントに応答します。コードは LED を適

切に切り替えます。アドバタイズが開始すると、アドバタイズ LED は点灯します。デバイスがアドバタイズを開

始し、接続の準備ができたため、切断 LED は消灯します。アドバタイズが停止したら、コードは LED を適切に

セットし、ハイバネートモードに移行するためのフラグをセットします。 

/* This event indicates peripheral device has started/stopped advertising */ 

 case CY_BLE_EVT_GAPP_ADVERTISEMENT_START_STOP: 

     DEBUG_PRINTF("CY_BLE_EVT_GAPP_ADVERTISEMENT_START_STOP: "); 

     if(Cy_BLE_GetAdvertisementState() == CY_BLE_ADV_STATE_ADVERTISING) 

     { 

       DEBUG_PRINTF("Advertisement started \r\n"); 

       Cy_GPIO_Write(Advertising_LED_0_PORT, Advertising_LED_0_NUM, LED_ON); 

       Cy_GPIO_Write(Disconnect_LED_0_PORT, Disconnect_LED_0_NUM, LED_OFF); 

     } 

     else if(Cy_BLE_GetAdvertisementState() == CY_BLE_ADV_STATE_STOPPED) 

     { 

       DEBUG_PRINTF("Advertisement stopped \r\n");   

       Cy_GPIO_Write(Advertising_LED_0_PORT, Advertising_LED_0_NUM, LED_OFF); 

       Cy_GPIO_Write(Disconnect_LED_0_PORT, Disconnect_LED_0_NUM, LED_ON); 

                 

       /* Advertisement event timed out before connection, shutdown BLE  

        * stack to enter hibernate mode and wait for device reset event 

        * or SW2 press to wake up the device */           

       Cy_BLE_Stop();              

     }  

     break;             
このプログラムコードでは、ハンドラは「切断」イベントに応答します。LED を正しくセットし、ハイバネート

フラグをセットします。 
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  /* This event is generated when disconnected from remote device or  

     failed to establish connection. */ 

 

  case CY_BLE_EVT_GAP_DEVICE_DISCONNECTED:    

      if(Cy_BLE_GetConnectionState(appConnHandle) == 

CY_BLE_CONN_STATE_DISCONNECTED) 

      { 

        DEBUG_PRINTF("CY_BLE_EVT_GAP_DEVICE_DISCONNECTED %d\r\n",  

CY_BLE_CONN_STATE_DISCONNECTED); 

        alertLevel = CY_BLE_NO_ALERT; 

        

       Cy_GPIO_Write(Advertising_LED_0_PORT, Advertising_LED_0_NUM, LED_OFF); 

       Cy_GPIO_Write(Disconnect_LED_0_PORT, Disconnect_LED_0_NUM, LED_ON); 

 

       /* Enter into discoverable mode so that remote device can search it */      

       apiResult = Cy_BLE_GAPP_StartAdvertisement(CY_BLE_ADVERTISING_FAST, 

CY_BLE_PERIPHERAL_CONFIGURATION_0_INDEX); 

       

       if(apiResult != CY_BLE_SUCCESS) 

       { 

         DEBUG_PRINTF("Start Advertisement API Error: %d \r\n", apiResult);   

         ShowError(); 

         /* Execution does not continue beyond this point */ 

       } 

       else 

       { 

         DEBUG_PRINTF("Start Advertisement API Success: %d \r\n", apiResult); 

         Cy_GPIO_Write(Advertising_LED_0_PORT, Advertising_LED_0_NUM, LED_ON); 

         Cy_GPIO_Write(Disconnect_LED_0_PORT, Disconnect_LED_0_NUM, LED_OFF); 

        } 

      } 

        break; 
これらのプログラムコードは、イベント ハンドラがイベントにどのように応答するかを示します。各イベントの

処理方法を確認するために、実際の関数を調べてください。 

5. サービス固有のイベント ハンドラを実装 

BLE コンポーネントはまた、デザインでサポートされる各サービスに対応するイベントを生成します。ファイン

ド ミー ターゲット アプリケーションでは、BLE コンポーネントはアラートレベル特性が新しい値で更新された

ことをアプリケーションに知らせる IASイベントを生成します。イベント ハンドラは新しい値を取得し、それを

alertLevel 変数に格納します。メイン ループは現時点のアラート レベルに基づいてアラート LED を切り替え

ます。 

図 43に IASイベント ハンドラ フローチャートを示します。 

図 43. BLE IASイベントハンドラのフローチャート 
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このプログラムコードは、ファームウェアがこのタスクをどのように遂行するかを示します。 

void IasEventHandler(uint32 event, void *eventParam) 

{ 

    /* Alert Level Characteristic write event */ 

    if(event == CY_BLE_EVT_IASS_WRITE_CHAR_CMD) 

    { 

        /* Read the updated Alert Level value from the GATT database */ 

        Cy_BLE_IASS_GetCharacteristicValue(CY_BLE_IAS_ALERT_LEVEL,  

            sizeof(alertLevel), &alertLevel); 

    } 

 

    /* To remove unused parameter warning */ 

    eventParam = eventParam; 

} 

 

 

6. 発生したイベントを処理 (メイン ループ) 

メインループは単に BleFindMe_Process() を呼び出します。図 44に BleFindMe_Process() フローチャート

を示します。 

図 44. ファームウェアのメインループのフローチャート 
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保留中の BLE ホストイベントがなく、アクティブな相互作用がない場合、アプリケーションは低消費電力モード

に入ります。その後、BLEにイベントを処理するよう指示し、アラートレベルに基づいて LEDを更新します。 

        /* The call to EnterLowPowerMode also causes the device to enter hibernate 

       mode if the BLE is disconnected. */ 

    EnterLowPowerMode(); 

    /* Cy_Ble_ProcessEvents() allows BLE stack to process pending events */ 

    Cy_BLE_ProcessEvents(); 

     

    /* Update Alert Level value on the Blue LED */ 

    switch(alertLevel) 

    {         

        case CY_BLE_NO_ALERT: 

            /* Disable MCWDT interrupt at NVIC */         

            NVIC_DisableIRQ(MCWDT_isr_cfg.intrSrc); 

            /* Turn the Blue LED OFF in case of no alert */ 

            Cy_GPIO_Write(Alert_LED_0, LED_OFF); 

            break; 

 

        /* Use the MCWDT to blink the Blue LED in case of mild alert */ 

        case CY_BLE_MILD_ALERT: 

            /* Enable MCWDT interrupt at NVIC */                

            NVIC_EnableIRQ(MCWDT_isr_cfg.intrSrc); 

            /* The MCWDT interrupt handler will take care of LED blinking */ 

            break; 

 

        case CY_BLE_HIGH_ALERT: 

            /* Disable MCWDT interrupt at NVIC */ 

            NVIC_DisableIRQ(MCWDT_isr_cfg.intrSrc); 

            /* Turn the Blue LED ON in case of high alert */ 

            Cy_GPIO_Write(Alert_LED_0, LED_ON); 

            break; 

             

        /* Do nothing in all other cases */         

        default: 

            break; 

} 

          

以上、サンプル コードを用いてファームウェアの動作概要を説明しました。理解を深めるために、ご自由にソース 

ファイルをご活用ください。 

5.8 パート 5: プロジェクトのビルド、デバイスのプログラミング 

ここでは、PSoC 6 BLE デバイスのプログラム方法を説明します。内蔵プログラマを備えた開発キット (CY8CKIT-

062-BLE PSoC 6 BLE Pioneer Kit など) をご使用の場合、USB ケーブルを使用して基板をコンピュータに接続しま

す。ご自身でハードウェア開発をされている場合、サイプレス CY8CKIT-002 MiniProg3などのハードウェア プログ

ラマ／デバッガが必要な場合があります。 

パス 
最初からの作業 

サンプル コードを参考とする 

サンプル コードを使用 

PSoC Creatorまたは BLEに詳しくない 

サンプル コードを使用 

PSoC Creatorと BLEに精通している 

アクション すべてのステップを行う 

 

最初から作業を行い、かつエラーが発生した場合、前のステップに戻って必要な作業がすべて完了したことを確認し

ます。これらの最終ステップでは、エラーを解決するか、サンプル コードに切り替えます。 
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http://www.cypress.com/cy8ckit-062-ble
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1. デバッグ ターゲットを選択 

PSoC Creatorは 1度に 1つのコアをデバッグできます。  

A. 図 45に示すように、PSoC Creatorで Debug > Select Debug Targetを選択します。 

図 45. デバッグ ターゲットを選択 

  

B. 基板に接続します。 

図 46 に示すように、Select Debug Target ダイアログボックスで CM4 ターゲットを選択し、OK または

Connectをクリックします。 

図 46. デバイスへ接続 

 

ヒント: 基板をプログラムする際に、いずれかのターゲットを選択できます。コアは同じメモリ空間を共有します。

いずれかのコアのプログラミングは、両方のコアがプログラムされます。しかし、デバッグの場合は、この選択が重

要です。デバッガには、接続するコアだけが表示されます。これらの命令ではデバッガを使用しません。 
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2. 基板をプログラム 

図 47に示すように、Debug > Programを選択し、プロジェクトをデバイスにプログラムします。 

図 47. デバイスをプログラム 

  

図 48に示すように、PSoC Creatorウィンドウの左下隅にプログラミング状態が表示されます。 

図 48. プログラミングの状態 

 

デュアルコア アプリケーションでは、リンカ ファイルは各実行ファイルをメモリの正しい場所に配置します。実行

は CM0+コアで開始され、次に CM4コアが有効にされます。 

プログラミングが完了すると、アプリケーションは実行します。LED が緑色に点灯し、ターゲットがアドバタイズ

していることを示します。アドバタイズ タイムアウトが発生した後、LED は赤色に変わり、切断されていることを

示します。 

ヒント: Debug > Debug コマンドを使用しても基板をプログラムできます。コードを生成またはリビルドする必要

がある場合、Program または Debug コマンドを発行するとコードの生成またはリビルドは自動的に実行されます。

また、基板をプログラミングせずにデバッグもできます。ただし、これらのインストラクションではデバッガを使用

しません。 

注: キットの KitProg2ファームウェアはアップデートが必要な場合があります。ファームウェアを更新する手順につ

いては、キットのユーザーガイドを参照してください。 
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5.9 パート 6: デザインをテストする 

ここでは、CySmartモバイル アプリケーションまたは CySmartホスト エミュレーション ツールを使用して BLE設

計をテストする方法について説明します。図 8 に、BLE Pioneer Kit を使用して設計をテストするための設定を示し

ます。 

パス 
最初からの作業 

サンプル コードを参考とする 

サンプル コードを使用 

PSoC Creatorまたは BLEに詳しくない 

サンプル コードを使用 

PSoC Creatorと BLEに精通している 

アクション ステップ 1またはステップ 2のいずれかを行う 

 

1. CySmartモバイル アプリ使用によるテスト 

A. ご使用の iOSまたは Androidモバイル機器の Bluetooth機能をオンにします。 

B. CySmartアプリケーションを起動します。 

C. BLE Pioneer Kit のリセットスイッチを押して、開発するデザインから BLE アドバタイズを開始します。

CySmartアプリがデバイスを認識できるようにするためには、緑色のLEDが点灯している必要があります。 

D. CySmart アプリのホーム画面をプルダウンして、BLE ペリフェラルのスキャンを開始します。ファインド  

ミー ターゲットは、CySmartアプリのホーム画面に BLEデバイスとして表示されます。タップして BLE接

続を確立します。モバイル機器がターゲットを見つけられない場合、リセットボタンをもう一度押すか、

CySmartホストエミュレーションツールを試してください (ステップ 2)。 

E. カルーセルビューから「Find Me」プロファイルを選択します。 

F. Find Me プロファイル画面で、Alert Level 値を選択し、ご使用の機器上の青色 LED の状態が選択に応じて

変化することを観察します。 

図 49には、iOSアプリを使用したこのプロセスを示します。図 50には、Androidアプリを使用したこのプロセス

を示します。 

図 49. iOS向け CySmartアプリでのテスト 
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図 50. Android向け CySmartアプリでのテスト 

 

 

2. CySmartホスト エミュレーション ツール使用によるテスト 

CySmart モバイルアプリの代わりに、CySmart ホストエミュレーションツールを使用し、開発するデザインとの

BLE接続を確立し、BLE特性への読み書き操作を実行できます。 

A. インストールされていない場合、CySmartホスト エミュレーション ツールをインストールします。 

図 51に示すように、トップ回路図上の BLEコンポーネントシンボルを右クリックし、Download CySmart

を選択します。インストーラーの指示に従ってツールをインストールします。 

図 51. CySmartのダウンロード 
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B. BLE ドングルをご使用の Windows PC に接続します。ドライバー インストールが完了するまでお待ちくだ

さい。 

C. CySmartホストエミュレーションツールを起動します。 

ツールは自動で BLEドングルを検出します。BLEドングルが Select BLE Dongle Targetポップアップウィ

ンドウに表示されない場合、Refresh をクリックします。図 52 に示すように、Connect をクリックします。 

図 52. CySmartでの BLEドングル選択 

 

注: ドングルのファームウェアが古い場合は、警告が表示されます。このステップを完了する前に、ファー

ムウェアをアップグレードする必要があります。ウィンドウの指示に従って、ドングルのファームウェアを

更新します。 

D. 図 53に示すように、Configure Master Settingsをクリックし、Restore Defaultsをクリックします。その

後、OKをクリックします。 

図 53. CySmart Master Settings設定 

  

E. BLE Pioneer Kit 上のリセットスイッチを押して、開発するデザインから BLE アドバタイズを開始します。

LEDは緑色に変わり、アドバタイズしていることを示します。 
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F. CySmartホスト エミュレーション ツールで、Start Scanをクリックします。図 54に示すように、ご使用機

器の名称 (Find Me Targetとして設定されている) が Discovered devicesリストに表示されます。 

注: ターゲットが見つけられず、スキャン プロセスがタイムアウトした場合、LEDは赤色に変わります。再

びリセットボタンをクリックし、アドバタイズを再始動します。  

図 54. CySmartでのデバイス検出 

 

G. 図 55に示すように、Find Me Targetを選択し、Connectをクリックして、CySmartホストエミュレーショ

ンツールとの BLE接続を確立します。 

図 55. CySmartでのデバイス接続 

 

H. 図 56 に示すように、接続後、Find Me Target デバイスタブに切替え、CySmart ホストエミュレーション 

ツールで開発するデザインのすべての属性を検出します。 

図 56. CySmartでの属性検出 

 

I. Attributesウィンドウをスクロールダウンし、Immediate Alertサービスのフィールドを探します。図 57に

示すように、Immediate Alert サービスの下の Alert Level 特性に 0、1、または 2 の値のいずれかを書き込

みます。アラートレベル特性の設定ごとに、ご使用のデバイス上の LED状態変化を観察します。  
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図 57. CySmartホスト エミュレーション ツールでのテスト 

 

J. 検索が終了したら、CySmart アプリケーションの Disconnect ボタンをクリックします。LED は赤色に変わ

り、切断されたことを示します。 

このプロセスを繰り返すためには、基板上のリセット ボタンを押してアドバタイズを再始動します。  

http://www.cypress.com/
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6 まとめ 

本アプリケーション ノートは PSoC 6 BLE デバイス アーキテクチャおよび関連する開発ツールを説明しました。

PSoC 6 BLEは、単一のチップ上に低消費電力 BLE無線ブロック、コンフィギュレーション可能なアナログとデジタ

ル ペリフェラル機能、メモリおよびデュアル CPU の CPU システムを集積した、真のプログラマブル組込みシステ

ムオンチップです。統合された機能および低消費電力モードを備えるため、PSoC 6 BLEはバッテリ駆動のウェアラ

ブル機器、ヘルスケアやフィットネスの BLEアプリケーションに最適です。 

7 関連アプリケーションノートとサンプル コード 

PSoC 6 MCUサンプル コードの完全で最新のリストについては、サンプル コードのウェブページをご覧ください。

PSoC 6 MCU関連のドキュメントについては、PSoC 6 MCU製品のウェブページをご覧ください。 

表 3 は、PSoC 6 BLE と PSoC Creator の学習の次段階のために推奨されるシステム レベルおよび一般的なアプリ 

ケーション ノートを一覧にします。 

表 3. 一般的なシステムレベルのアプリケーションノート、サンプル コード 

文書番号 文書名 

AN221774 Getting Started with PSoC MCU on PSoC Creator 

CE221773 PSoC 6 MCU Hello World Example 

AN218241 PSoC 6 MCUハードウェア設計上の注意事項 

AN219434 PSoC 6 MCU ― 生成コードの IDEへのインポート 

AN219528 PSoC 6 MCU低消費電力モードおよび節電技術 

 

表 4 は、デバイスの特定ペリフェラルおよびアプリケーションのアプリケーション ノートおよびサンプル コード 

(CE) を示します。  

表 4. PSoC 6 BLE機能に関連する資料 

文書番号 文書名 

Bluetooth Smart 

AN91162 BLEカスタム プロファイルの作成について 

AN91445 アンテナの設計および高周波レイアウト ガイドライン 

AN92584 BLEアプリケーション向け低消費電力の設計およびバッテリ寿命推測 

CE218463 Bluetooth Low Energy（BLE）アラート通知クライアント/サーバー 

CE218464 Bluetooth Low Energy（BLE）Phone Alertクライアント/サーバー 

システム リソース、CPU、割込み 

AN215656 PSoC 6 MCUデュアル CPUシステム設計 

AN217666 PSoC 6 MCU割込み 

CE216795 PSoC 6 MCU Dual-CPU Basics 

CE216825 PSoC 6 MCU Real-Time Clock Basics 

CE218129 PSoC 6 MCU Wake up from Hibernate Using Low Power Comparator 

CE218541 PSoC 6 MCU Fault-Handling Basics 

CE218542 PSoC 6 Custom Tick Timer Using RTC Alarm Interrupt 

CE218552 PSoC 6 MCU UART to Memory Buffer Using DMA 

CE218964 PSoC 6 MCU RTC Daily Alarm 

CE219339 PSoC 6 MCU MCWDT and RTC Interrupts (Dual Core) 

CE219521 PSoC 6 MCU GPIO Interrupt 

http://www.cypress.com/
http://www.cypress.com/search-results?as_q=psoc%206%20mcu%20code%20examples
http://www.cypress.com/psoc6
http://www.cypress.com/an221774
http://www.cypress.com/ce221773
http://www.cypress.com/an218241
http://www.cypress.com/an219434
http://www.cypress.com/an219528
http://www.cypress.com/documentation/application-notes/an91162-creating-ble-custom-profile
http://www.cypress.com/documentation/application-notes/an91445-antenna-design-and-rf-layout-guidelines
http://www.cypress.com/documentation/application-notes/an92584-designing-low-power-and-estimating-battery-life-ble?source=search&keywords=AN92584
http://www.cypress.com/ce218463
http://www.cypress.com/ce218464
http://www.cypress.com/an215656
http://www.cypress.com/an217666
http://www.cypress.com/ce216795
http://www.cypress.com/ce216825
http://www.cypress.com/ce218129
http://www.cypress.com/ce218541
http://www.cypress.com/ce218542
http://www.cypress.com/ce218552
http://www.cypress.com/ce218964
http://www.cypress.com/ce219339
http://www.cypress.com/ce219521
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文書番号 文書名 

CE219881 PSoC 6 MCU Switching Power Modes 

CE220060 PSoC 6 MCU Watchdog Timer 

CE220061 PSoC 6 MCU Multi-Counter Watchdog Interrupts 

CE220120 PSoC 6 MCU Blocking Mode Flash Write 

CE220169 PSoC 6 MCU Periodic Interrupt Using TCPWM 

GPIO 

CE219490 PSoC 6 Breathing LED Using SMART IO 

CE219506 PSoC 6 Clock Buffer Using SMART IO 

CE220263 PSoC 6 MCU GPIO Pins Example 

CapSense 

AN92239 Proximity Sensing with CapSense 

AN85951 PSoC 4および PSoC 6 MCU CapSenseデザインガイド 

ブートローダ 

AN213924 PSoC 6 MCUデバイス ファームウェア アップデート ソフトウェア開発キット ガイド 

CE213903 PSoC 6 MCU Basics Bootloaders 

通信 

CE220541 PSoC 6 MCU SCB EzI2C 

オーディオ 

CE218636 PSoC 6 MCU Inter-IC Sound (I2S) Example 

CE219431 PSoC 6 MCU PDM-to-PCM Example 

RTOS 

CE217911 PSoC 6 FreeRTOS™ Example Project 

セキュリティ 

CE220465 PSoC 6 MCU Cryptography – AES Demonstration 

CE220511 PSoC 6 MCU Cryptography – SHA Demonstration 

 

 

http://www.cypress.com/
http://www.cypress.com/ce219881
http://www.cypress.com/ce220060
http://www.cypress.com/ce220061
http://www.cypress.com/ce220120
http://www.cypress.com/ce220169
http://www.cypress.com/ce219490
http://www.cypress.com/ce219506
http://www.cypress.com/ce220263
http://www.cypress.com/documentation/application-notes/an92239-proximity-sensing-capsense
http://www.cypress.com/an85951
http://www.cypress.com/an213924
http://www.cypress.com/ce213903
http://www.cypress.com/ce220541
http://www.cypress.com/ce218636
http://www.cypress.com/ce219431
http://www.cypress.com/ce217911
http://www.cypress.com/ce220465
http://www.cypress.com/ce220511
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Appendix A. 用語集 

ここでは、サイプレスの PSoCデバイス ファミリで操作する際によく出てくる用語について説明します。 

Component Customizer： PSoC Creatorのシンプルな GUIで各コンポーネントに埋め込まれています。コンポーネ

ント パラメーターをカスタマイズするために使用され、コンポーネントを右クリックすることでアクセスされます。 

Components：コンポーネントは、メインシステムバスを介して MCUに本質的に接続されている 1つの PSoCコン

ポーネントに複数の IC およびシステムインターフェイスを統合するために使用されます。例えば、BLE コンポーネ

ントは Bluetooth Smart製品を数分で作成します。同様に、プログラマブル アナログ コンポーネントをセンサー用に

使用できます。 

MiniProg3：開発用プログラミングハードウェアであり、開発する基板または内蔵プログラマを備えない PSoC開発

キット上の PSoCデバイスをプログラミングするために使用されます。 

PSoC：32 ビット CM4 などの 1 つ以上の CPU を含み、アナログとデジタル ブロックを内蔵するプログラム可能な

組込み設計プラットフォームです。タッチセンシングなどの信頼性が高く使いやすいソリューションで組込みシステ

ム設計を加速させ、低消費電力の設計を可能にします。 

PSoC Creator：開発を行うお客様の PCにインストールされた PSoC 3、PSoC 4、PSoC 5LP、および PSoC 6 BLE 

IDE ソフトウェアであり。PSoC システムのハードウェアとファームウェアの同時に設計するか、またはハードウェ

ア設計後に一般的な IDEへエクスポートすることをを可能にします。  

Peripheral Driver Library：Peripheral Driver Library (PDL) は、PSoC 6 MCUアーキテクチャのソフトウェア開発を

簡素化します。PDL は、レジスタの使用法とビット構造を理解する必要性を減らし、使用可能な広範な周辺機器の

ソフトウェア開発を容易にします。 

PSoC Programmer: PSoCデバイスをプログラムするための柔軟性のある統合プログラミング アプリケーションで

す。PSoC Programmerは PSoC Creatorと統合され、PSoC 3、PSoC 4、PRoC、PSoC 5LP、および PSoC 6 MCU

デザインをプログラムします。 

http://www.cypress.com/
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-002-psoc-miniprog3-program-and-debug-kit
http://www.cypress.com/go/psoc
http://www.cypress.com/go/creator
http://www.cypress.com/documentation/software-and-drivers/peripheral-driver-library-pdl
http://www.cypress.com/go/programmer
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Appendix B. BLEプロトコル 

B.1 概要 

BLE (Bluetooth Smartとも呼ばれている) は、2.4GHz ISM帯で動作する低消費電力の無線規格として Bluetooth SIG

により策定されました。図 58に BLEプロトコル スタックを示します。 

図 58. BLEアーキテクチャ 
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BLEスタックは以下の 3グループに分けられています。 

▪ コントローラー: 物理デバイスで、パケットを暗号化して無線信号として送信します。信号の受信時、コントロ

ーラーは無線信号を復号してパケットを復元します。 

▪ ホスト: セキュリティ マネージャ、属性プロトコルなどの様々なプロトコルとプロファイルを含むソフトウェア 

スタックであり、2つ以上のデバイスがどのように他のデバイスに通信するかを管理します。 

▪ アプリケーション: ソフトウェア スタックとコントローラーを使用して特定の機能を実装するユースケースです。 

下記では、標準的な心拍数監視サービスとバッテリ サービスを例として取り上げて BLE スタックの複数の層の概要

について説明します。BLE アーキテクチャの詳細説明については、Bluetooth Developer のサイトに搭載されている

Bluetooth 4.2仕様または学習ビデオをご覧ください。 

B.2 物理層 (Physical Layer; PHY) 

物理層は、2.4GHz ISM 帯のガウス型周波数偏移変調 (GFSK) という変調方式を利用して 1Mbps でデジタル データ

を送受信します。この BLE の物理層は ISM 帯を 2MHz ごと 40 個の RF チャネルに分けており、その内データ チャ

ネルは 37個でアドバタイズ チャネルは 3個です。 

 

  

http://www.cypress.com/
https://developer.bluetooth.org/Pages/default.aspx
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B.3 リンク層 (Link Layer; LL) 

リンク層では、(認識およびフロー制御に基づいたアーキテクチャを利用して) 信頼性のある物理リンクを成立するた

めの重要な手続き、および堅牢で低消費電力の BLE プロトコルを実現する機能を実装します。以下はリンク層の機

能の一部です。 

▪ アドバタイズ、スキャン、接続の作成および維持: 物理リンクを確立 

▪ 24ビット CRCおよび AES-128ビット暗号化: データ交換時の堅牢性と安全さを確保 

▪ 高速接続の確立および低デューティ比のアドバタイズ: 低消費電力動作を実現 

▪ アダプティブ周波数ホッピング (Adaptive Frequency Hopping；AFH): パケット送信用の通信チャネルを変更し、

他のデバイスからの干渉を軽減 

リンク層では、次の 2つのロールが定義されます。 

▪ マスター：スマートフォンは、リンク層をマスターコンフィギュレーションに設定する例です。 

▪ スレーブ：心拍数モニターデバイスは、リンク層をスレーブコンフィギュレーションに設定する例です。 

PSoC 6 BLEデバイスはどちらのコンフィギュレーションでも動作できます。  

リンク層スレーブは自体の存在を他のリンク層マスターにアドバタイズするものです。リンク層マスターはアドバタ

イズ パケットを受信し、アプリケーションの要求に応じてスレーブとの接続を決定します (図 59 を参照してくださ

い)。この心拍数モニター アプリケーションの実装例では、心拍数モニター デバイスはスレーブとして動作し、デー

タをマスターとして動作するスマートフォンに送信します。スマートフォンアプリケーションは、スマートフォン上

に読み出し結果を表示します。 

PSoC 6 BLE デバイスは、アドバタイズ、CRC、および AES 暗号化などタイムクリティカルでプロセッサに集中す

るリンク層の機能をハードウェアで実装します。アドバタイズ状態に移行するか暗号化を開始するなどのリンク層制

御動作はファームウェアで実装されます。 

図 59 に、BLE のリンク層パケットの構造および各々のフィールドのサイズを示します。リンク層パケットは上層の

すべてのデータをペイロード フィールドに格納します。物理リンク上の通信を一意に識別し、同じ RFチャネルで動

作する近くの BLE デバイスからのパケットを無視するために 4 バイトのアクセスアドレスを持っています。24 ビッ

ト CRCによりデータの堅牢性を確保できます。 

図 59. BLEリンク層プロトコル 
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B.4 ホスト制御インターフェース (Host Control Interface; HCI) 

HCI は、ホストとコントローラー間の標準定義のインターフェースです。これによりホストとコントローラーがコ 

マンド、データ、イベントなどの情報を USB や UART のような異なる物理的転送方式で相互交換できます。コント

ローラーとホストは異なるデバイスの場合にのみ HCIに物理的転送が必要です。 

PSoC 6 BLEデバイスでは、HCIはコントローラーとホスト間でメッセージとイベントを転送するファームウェアプ

ロトコル層にすぎません。 

http://www.cypress.com/
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B.5 論理リンク制御および適応プロトコル (Logical Link Control and Adaptation Protocol；
L2CAP) 

L2CAP はプロトコルの多重化、分割、再構成のサービスを上層のプロトコルに提供します。分割サービスでは、上

位層から受信したパケットをリンク層が送信できるより小さいパケットに分割します。再構成サービスでは、リンク

層から受信した小さいパケットを組み合わせて意味のあるパケットに構成します。L2CAP層は、図 60に示すように、

アトリビュート プロトコル (Attribute Protocol; ATT)、セキュリティ管理 (Security Manager; SM) および L2CAP制御

用に 3つのプロトコル チャネル IDを提供します。Bluetooth 4.2仕様により、これらのプロトコル チャネルの上部に

ある L2CAP接続指向チャネルから直接データ チャネルを作成できます。 

PSoC 6 BLEでは、L2CAPとその上部にある各層がファームウェアで実装されます。 

図 60. BLE L2CAP層 
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B.6 セキュリティ管理 (Security Manager; SM) 

SM層は、ペアリング、暗号化、およびキーの配布の方法を定義します。 

▪ ペアリングは、セキュリティ機能を有効にするプロセスです。このプロセスでは、2 つのデバイスが認証され、

そのリンクが暗号化されてから、暗号化の鍵が交換されます。これにより、RF チャネル上でスパイによって探

られることなく、BLEインターフェースを介してデータが安全に交換できます。 

▪ ボンディングは、ペアリングプロセスで交換されたキーと識別情報が保存されるプロセスです。デバイスが 1度

ボンディングされたら、再接続する際に再度ペアリング プロセスを経過する必要はありません。 

BLEはデータ暗号化に 128ビット AESを使用します。  

B.7 アトリビュート プロトコル (Attribute Protocol; ATT) 

BLEの GATT仕様には、ATTと GATT層を理解するために把握する必要がある 2つのロールがあります。 

GATT サーバー：GATT サーバーはデータや情報を格納します。GATT クライアントからリクエストを受信し、

データで返答します。例えば、心拍数モニターの GATT サーバーには心拍数の情報を格納します。BLE 型 HID

キーボードの GATTサーバーは、ユーザーがキーを押す情報を格納します。 

http://www.cypress.com/
http://en.wikipedia.org/wiki/Advanced_Encryption_Standard
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▪ GATT クライアント：GATT クライアントは、GATT サーバーにデータをリクエストまたは受信します。たとえ

ば、スマートフォンは心拍数モニターの GATT サーバーから心拍数情報を受信する GATT クライアントです。

ノートパソコンは、BLEキーボードからキー押下情報を受信する GATTクライアントです。 

ATT は BLE 通信の基礎となっています。このプロトコルにより、GATT クライアントが GATT サーバーでデータや

属性を検索してアクセスできます。GATT クライアントとサーバーのアーキテクチャの詳細については、「汎用属性

プロファイル (Generic Attribute Profile; GATT)」を参照してください。  

属性は以下の内容を含む ATT/GATT層の基本的なデータコンテナーです。 

▪ 属性ハンドル：属性のアドレス指定し、そこにアクセスする 16ビットアドレスです。 

▪ 属性タイプ：属性に格納されるデータのタイプを指定します。これは Bluetooth SIGが定義した 16ビット UUID

で表わされます。 

例えば、心拍数管理サービスの 16ビット UUIDは 0x180Dで、デバイス名属性の UUIDは 0x2A00です。SIGに

よって割り当てられた 16ビット UUIDの一覧については、Bluetoothのウェブページをご利用ください。 

▪ 属性値：属性に格納される実際の値です。 

▪ 属性権限：属性へのアクセス、認証、および権限付与の要件を指定します。これは上層の仕様によって設定さ

れ、属性プロトコルをとおしてアクセスできません。 

図 61にデバイス名属性の構造を例として取り上げます。 

図 61. 属性フォーマットの例 
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B.7.1  属性階層  

属性はデータを表示する ATT／GATT での構成要素です。属性は次の 2 グループに大きく分けられ、データ階層と 

データ抽象化を提供します。 

▪ キャラクタリスティック (Characteristic)：システム情報または意味のあるデータを表わす属性のコレクション

です。キャラクタリスティックは、以下の属性を含みます。 

 キャラクタリスティック宣言属性 (Characteristic Declaration Attribute): キャラクタリスティックの開始を定

義します。 

 キャラクタリスティック値属性 (Characteristic Value Attribute): 実際のデータを格納します。 

 キャラクタリスティック ディススクリプタ属性：これらはオプションの属性であり、キャラクタリスティッ

ク値の追加情報を提供します。 

「バッテリレベル」は、バッテリサービス (BAS) のキャラクタリスティックの 1 例です。バッテリレベルをパーセ

ント値で表示するのは、キャラクタリスティック ディスクリプタの 1例です。 

図 62に、例としてバッテリレベルのキャラクタリスティックの構造を示します。  

 キャラクタリスティックの最初の部分は、その特性の宣言 (特性の開始) であり、図 62 にバッテリレベル特

性で示されています。 

 次は実際のキャラクタリスティック値 (実際のデータ) です。バッテリレベル特性の場合は現時点でのバッテ

リレベルです。バッテリ レベルは「65」、「90」などフル スケールに対する割合で表わされます。  

 キャラクタリスティック ディスクリプタは、キャラクタリスティック値を理解するために必要な追加情報を

提供します。例えば、バッテリ レベルのキャラクタリスティック表示形式ディスクリプタはバッテリ レベル
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をパーセントで表わされることを示します。よって、「90」を読み出すと、GATT クライアントは 90mV や

や 90mAhではなく 90%と理解します。同様に、(図 62に示されていない) 有効範囲のキャラクタリスティッ

ク ディスクリプタはバッテリ レベルの範囲が 0～100%であることを示します。 

 クライアント キャラクタリスティック コンフィギュレーション ディスクリプタ (CCCD) は、GATTクライ

アントが GATT サーバー上の特性の動作を設定できるようにする、もう 1 つの一般的に使用されるキャラク

タリスティック ディスクリプタです。GATTクライアントが 0x01の値を特性のCCCDに書き込むと、GATT

サーバーから非同期通知 (次のセクションで説明) を送信できるようになります。バッテリ レベル キャラク

タリスティックの場合、バッテリ レベル CCCD に 0x01 を書き込むと、バッテリ サービスがバッテリ レベ

ルを定期的に、またはバッテリ レベル値の変化に応じて通知できます。 

図 62. キャラクタリスティックのフォーマットと例 

<<Characteristic>>

<<Value>>

<<Descriptor>>

<<Descriptor>>

Format

Battery Level 

Characteristic

Battery Level

Client Characteristic 

Configuration Descriptor

Characteristic Presentation 

Format

Example

 

▪ サービス：GATTサーバーによって実行される機能を定義する属性の 1種です。サービスはキャラクタリスティ

ックの集合であり、他のサービスを含むこともあります。サービスの概念は、関連のあるデータのグループを確

立し、データ階層を提供するために使用されます。心拍数サービス (HRS) の例は、図 63を参照してください。 

サービスは、1 次サービスと 2 次サービスの 2 種類に分けられています。1 次サービスはデバイスの主な機能を

提供し、2次サービスは追加機能を提供します。例えば、心拍数モニターデバイスの場合、HRSは 1次サービス

で、BASは 2次サービスです。 

サービスには、GATT サーバー上にある他のサービスも含むことがあります。含まれているすべてのサービスは

新しいサービスの一部になります。 

図 63. BLE心拍数サービスの例 
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BLE の「プロファイル」という言葉は、特定の最終アプリケーションを一緒に実行する一連のサービスとその動作

です。心拍数プロファイル (HRP) は、心拍数モニターデバイスに必要なすべてのサービスを定義する BLEプロファ

イルの 1例です。詳細は「汎用アクセス プロファイル (Generic Access Profile; GAP)」を参照してください。 

図 64 に、このセクションの前で定義された属性、キャラクタリスティック、サービス、およびプロファイルを使用

するデータ階層を示します。 

図 64. BLEデータ階層* 

 

*Bluetooth SIGから画像提供 

B.7.2  属性の操作  

前節で定義された属性は、以下の 5つの基本的方法でアクセスされます。 

▪ 読み出しリクエスト：GATTクライアントはこのリクエストをGATTサーバーに送信して、属性値を読み出しま

す。リクエストごとに、GATTサーバーは GATTクライアントに応答を送信します。この読み出しリクエストの

1例は、スマートフォンが心拍数モニターデバイスのバッテリレベル特性 (図 62を参照) を読み出すことです。 

▪ 書き込みリクエスト：GATTクライアントはこのリクエストをGATTサーバーに送信して、属性値を書き込みま

す。GATTサーバーは GATTクライアントに応答し、値が書き込まれたかどうかを示します。書き込みリクエス

トの 1例は、スマートフォンが通知を有効にするためにバッテリレベル特性の CCCDに 0x01の値を書き込むこ

とです。 

▪ 書き込みコマンド：GATTクライアントは属性値の書き込みのために、このコマンドをGATTサーバーに送信し

ます。GATT サーバーはこのコマンドに対して何も応答を送信しません。例えば、BLE 即時アラートサービス 

(IAS) は、IASロケーター (スマートフォンなど) から IASターゲットデバイス (BLEキー フォブなど) のアラー

ト (LED のオンにする、ブザーを鳴らす、振動モーターを駆動するなど) をトリガするために書き込みコマンド

を使用します。 

▪ 通知：GATT サーバーは属性の新しい値を知らせるために、GATT クライアントに通知を送信します。GATT ク

ライアントはこの通知に対して何の確認も送信しません。例えば、心拍数モニター デバイスはその CCCD に

0x01が書き込まれると心拍数測定通知をスマートフォンに送信します。 
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▪ 指示：GATT サーバーはこのタイプのメッセージを送信します。GATT クライアントはそれに対して常に確認を

行います。例えば、BLE健康体温計サービス (Health Thermometer Service; HTS) は測定した体温の値を、スマ

ートフォンのような健康体温計コレクターに確実に送信するためにこれらの指示を使用します。 

 

B.8 汎用属性プロファイル (Generic Attribute Profile; GATT) 

GATTは、属性の検出と使用の方法を定義しています。GATTは以下の 2つのロールのいずれかで動作します。 

▪ GATTクライアント：データを要求するデバイス (例: スマートフォン) 

▪ GATTサーバー：データを提供するデバイス (例: 心拍数モニター) 

図 65に、心拍数モニター デバイスを例として GATT層のクライアントとサーバーのアーキテクチャを示します。心

拍数モニターデバイスは、複数のサービス (HRS、BAS、およびデバイス情報サービス) を提供し、それぞれのサー

ビスは図 62に示すように、特性値とディスクリプタを持つ 1つ以上の特性を持っています。 

図 65. GATTクライアントとサーバーのアーキテクチャ 
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BLE接続がリンク層レベルで確立された後、GATTクライアントは (最初に接続された BLEデバイスについて何も分

からず)、「サービス検出」というプロセスを開始します。サービス検出の一部として、GATT クライアントは複数

のリクエストを GATTサーバーに送信して、GATTサーバーで利用可能なすべてのサービス、特性、および属性のリ

ストを取得します。サービス検出が完了すると、GATTクライアントは、前述の属性操作を使用して GATTサーバー

が提供する情報の読み出しや修正に必要な情報を取得します。 

B.9 汎用アクセス プロファイル (Generic Access Profile; GAP) 

GAP 層はデバイス アドレス、デバイス名などのデバイス固有情報、および検出／接続／ボンディング方法を提供し

ます。プロファイルは、デバイスの検出方法、接続方法、使用可能なサービスのリスト、およびサービスの使用方法

を定義します。図 67に心拍数プロファイルの例を示します。 

GAP層は以下の 4つのロールのいずれかで動作します。  

▪ ペリフェラル: デバイスを GAP セントラルに接続することを可能にするアドバタイズ ロールです。セントラル

との接続が確立された後、デバイスはスレーブとして動作します。例えば、測定された心拍数をリモート デバ

イスに報告する心拍数センサーは GAPペリフェラルとして動作します。 

▪ セントラル: アドバタイズをスキャンし、ペリフェラルとの接続を開始する GAPロールです。この GAPロール

は、ペリフェラルとの接続が確立した後、マスターとして動作します。例えば、ペリフェラル (心拍数センサー) 

から心拍数測定データを受信したスマートフォンは、GAPセントラルとして動作します。 

▪ ブロードキャスター: データを放送するのに使用されるアドバタイズ ロールです。BLE接続を確立できず、デー

タ交換にも関与しません (要求／応答動作なし)。このロールは、聞き手の有無に係わらずデータを連続して送信

するラジオ放送局と同様の役割を果たしています。これは一方向データ通信です。GAP ブロードキャスターの

典型的な 1例は、情報を継続的に放送するが、いかなる応答も期待しないビーコンです。 

▪ オブザーバー: アドバタイズをスキャンするリスニング ロールですが、アドバタイズ デバイスには接続しませ

ん。これはブロードキャスター ロールの逆ロールです。情報を継続的に聞き取りますが、情報源と通信できな
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いラジオ受信機と同様に動作します。GAP オブザーバーの典型的な 1 例は、継続的にビーコンを聞くスマート

フォン アプリです。 

図 66に、サイプレスの BLE Pioneer Kitをペリフェラルとして、スマートフォンをセントラルデバイスとして使用し

た一般的な BLEシステムを示します。また、BLEプロトコル層とセントラルおよびペリフェラル デバイスのロール

の間の相互作用も示します。 

図 66. BLEシステムの設計 
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図 67 は心拍数アプリを備えたスマートフォンがセントラルとして動作し、心拍数センサーはペリフェラルとして動

作する例を示します。心拍数モニターデバイスは心拍数センサープロファイルを実装し、データを受信するスマート

フォンは心拍数コレクタープロファイルを実装します。 

この例では、心拍数センサープロファイルは 2つの標準サービスを実装しています。1つ目は、3つの特性 (心拍数測

定特性、身体センサーの位置特性、および心拍数制御点特性) で構成される心拍数サービスです。2 つ目のサービス

は、デバイス情報サービスです。Link Layer で、心拍数測定デバイスはスレーブであり、スマートフォンはマスター

です。心拍数サービスとプロファイルの詳細は Bluetooth開発者ポータルを参照してください。 
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図 67. BLE心拍数モニターシステム 
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Appendix C. デバイスの特長 

C.1 システム ワイド リソース 

C.1.1  CPU サブシステム：CM4 および CM0 

PSoC 6 BLEの CPUサブシステムは、2つの Cortexコアで構成されています。150MHzの最大周波数で動作可能な

単精度浮動小数点ユニットを備えた CM4。および最大周波数 100MHz で動作可能な CM0+です。両方のコアでメモ

リ保護ユニット (MPU) があります。さらに、ペリフェラル保護ユニット (PPU) と呼ばれるペリフェラルに接続され

た保護ユニットと、共有メモリ領域用の共有メモリ保護ユニット (SMPU) があります。 

CM0+は、セキュアブート機能も提供します。この機能によって、ブート後にシステムの整合性が保護され、ユー 

ザー アプリケーションの実行に先立つ特権が適用されます。  

C.1.2  IPC 

プロセッサ間通信 (IPC) は 2 つのコアが通信を行い、アクティビティを同期させるための機能を提供します。IPC 

ハードウェアは PSoC 6 BLEのレジスタ構造を使用して実装されます。これらのレジスタ構造は、イベントを同期さ

せ、IPCチャネルの「通知」イベントまたは「解放」イベントをトリガするために使用されます。PSoC 6 BLEは最

大 16チャネルがあり、CPUコア間でメッセージを受け渡すことができ、相互排除によるロックをサポートします。 

C.1.3  メモリ  システム  

CPUコアにはメモリとペリフェラルへの共有アクセスを可能にする固定メモリ アドレス マップを持ちます。コード

は両方のコアでフラッシュと RAMの両方から実行できます。  

PSoC 6 BLEファミリには、最大1MBのフラッシュメモリと、EEPROMエミュレーションに使用できる追加の32KB

のフラッシュがあります。追加の 32KB の監視フラッシュもあります。さらに、フラッシュは Read-While-Write 

(RWW) 動作をサポートし、これにより、CPUが命令を実行している時にフラッシュに書き込みができます。ブート

ルーチンとコンフィギュレーション ルーチンを含む 128KB ROMもあります。これにより、エンド アプリケーショ

ンにユーザー フラッシュの認証が必要な場合、セキュア ブート動作が確実に行われます。 

PSoC 6 BLEには最大 288KBの SRAMメモリがあり、完全に保持することも、ユーザー指定の 32KBブロック単位

で保持することもできます。 

C.1.4  DMA 

CPUサブシステムには2つの独立したDMAコントローラーが含まれており、それぞれ32チャネルで実行できます。

コントローラーは、Arm標準の Advanced Microcontroller Bus Architecture (AMBA) 高性能バス (AHB) を使用して、

周辺機器への独立したアクセスをサポートします。 

DMA はメモリ、ペリフェラルおよびレジスタとの間でデータを転送します。これらの転送は、CPU から独立して行

われます。DMAチャネルは以下をサポートします。 

▪ ソース側とデスティネイション側で 8ビット、16ビット、32ビットのデータ幅 

▪ チャネルごとに 4つの優先度レベル 

▪ 各 DMAディスクリプタで設定可能な割込み 

▪ ディスクリプタ チェーン 

C.1.5  クロック  システム  

PSoC 6 BLEは以下のクロック ソースがあります。 

▪ 内部主発振器 (IMO): IMOは、PSoC 6 BLE内部クロックの 1次ソースです。CPUおよびすべての高速ペリフェ

ラルは IMOまたは外部水晶発振器 (WCO) から動作できます。PSoC 6 BLEは IMOまたは ECOのいずれかから

動作する多数のペリフェラル クロック分周器があります。これらの分周器は高速のペリフェラルにクロックを

生成します。IMOは 8MHzクロックを±1％の精度で生成でき、アクティブモードでのみ使用できます。 

▪ 外部水晶発振器 (ECO): PSoC 6 MCUデバイスは、正確なクロックソースのために 4MHzから 33.33MHzの外部

水晶を駆動する発振器を含みます。 
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さらに、調整可能な組込みの水晶負荷容量を備えた BLE サブシステムの外部水晶発振器を使用して、高精度の

32MHz クロックを生成します。主に、RF クロックを生成する BLE サブシステムのクロックに使用されます。

高精度 ECOクロックは、PSoC 6 BLEデバイスの高周波クロック (CLK_HF) のクロックソースとしても使用で

き、AltHFクロックとして指定されています。 

▪ 外部クロック (EXTCLK): 外部クロックはメガヘルツ範囲のクロックで、指定された I/O ピンの信号から供給で

きます。このクロックは PLLまたは FLL のソース クロックとして使用でき、また高周波クロックによって直接

使用もできます。 

▪ 内部低速発振器 (ILO): ILO は非常に低消費電力の 32kHz 発振器であり、主にすべての電力モードで動作する低

速周辺機器用のクロックを生成します。 

▪ 高精度内部低速発振器 (PILO): PILOは、ILOよりも正確な32.768kHzクロックを提供できる追加のソースです。

PILOはディープ スリープ以上のモードで動作します。 

▪ 時計用水晶発振器 (WCO): 32.768kHz WCOは、ILO／PILOとともに低周波数クロックツリー (CLK_LF) のソー

スの 1つとして使用されます。WCOは BLEアドバタイズおよび接続イベントの時間間隔を正確に維持するため

に使用されます。ILOと同様にWCOはハイバネートとストップ モードを除くすべてのモードで使用可能です。 

PSoC BLEクロック生成システムには、位相ロックループ (PLL) および周波数ロックループ (FLL) ブロックがあり、

これらを使用して高周波クロック (CLK_HF) を生成できます。これらの高周波クロックは、CPUコア クロックとペ

リフェラル クロック分周器を駆動します。  

PSoC 6 BLEは 5つの高周波ルート クロック (CLK_HF[0～4]) を持っています。各 CLK_HFには、シリアルメモリイ

ンターフェイスなどのペリフェラルなどのデバイス上の宛先があります。 

PSoC 6 BLEは、高周波クロックパス 0 (CLK_HF [0]) およびWCOにクロック監視機能を備えており、クロックが停

止したかどうかを検出して、割込みまたはシステムリセット、あるいはその両方をトリガできます。 

C.1.6  システム割込み  

PSoC 6 BLEは、両方の CPUコア (CM4および CM0+) での割込みおよび例外をサポートします。コアは、割込み／

例外を処理するための独立したベクトル テーブルを提供します。PSOC 6 BLEは、CM4で最大 139の割込み、CM0+

で最大 32の割込みをサポートできます。最大 33個の割込みにより、デバイスをディープスリープ電力モードからウ

ェイクアップできます。 

C.1.7  電源と電圧監視  

PSoC 6 BLEデバイス ファミリは、1.71V～3.6Vの動作電圧をサポートします。これにはデバイス内のブロックに電

力を供給するためにシングル入力マルチ出力 (SIMO) 降圧コンバータを内蔵しています。コアの動作電圧は、0.9V〜

1.1V の間でユーザーが選択できます。デバイスファミリは、VDDD、VDDA、VDDIO、および VBACKUP の複数の電源レー

ルをサポートします。さらに、BLE 無線操作用の電源レール– VDDR があります。アプリケーションの電源レール／

ピンの利用可能性については、選択されたデバイス パッケージによって異なります。 

このデバイスには、RTCやWCOなどの周辺機器の小さなセットに電力を供給する VBACKUP電源ピンが含まれていま

す。このレールは他のすべてのレールとは独立しており、他のレールがない場合でも提供できます。これらのブロッ

クへの電源は専用の VBACKUPピンから供給されるため、これらのブロックは、デバイスの電源が切断されているか、

リセット状態に保持されている場合でも動作し続けます。バックアップ ドメインにある RTC は、任意の消費電力 

モードからデバイスをウェイク アップするオプションを提供します。 

PSoC 6 BLEファミリは、パワーオンリセット (POR)、電圧低下検出 (BOD)、過電圧保護 (OVP)、および電源監視用

の低電圧検出 (LVD) 回路をサポートし、フェイルセーフ回復を実装します。 

PSoC 6 BLEの電源の詳細については、PSoC 6 MCU：PSoC 63 with BLE Architecture Technical Reference Manual

を参照してください。 

C.1.8  電力モード  

消費電力の大きい順での PSoC 6 BLEがサポートする消費電力モードは以下のとおりです。 

▪ アクティブ モード: これは動作の主モードです。このモードでは、すべてのペリフェラルがアクティブになり、

利用可能です。 
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▪ 低消費電力アクティブモード: このモードはアクティブモードに似ており、ほとんどの周辺機器は限られた機能

で動作します。CPU コアが利用可能です。性能のトレードオフには、動作クロック周波数の低下、周波数が制

限された高周波クロックソース、およびコア動作電圧の低下が含まれます。 

▪ スリープ モード: このモードでは、CPUがスリープ モードであり、SRAMは保持状態、すべてのペリフェラル

が利用可能です。割込みが発生すると、いずれかの CPU を起動し、システムをアクティブモードに戻します。

CM4と CM0+はどちらも独立の CPUスリープモードをサポートしており、各 CPUは他の CPUの状態に関係な

くスリープ状態にできます。両方のコアがスリープ状態である場合、デバイスはスリープ モードになります。 

▪ 低消費電力スリープモード: ほとんどのペリフェラルが制限された機能で動作し、CPUコアは使用できません。 

▪ ディープ スリープ モード: ディープ スリープ モードでは、すべての高速クロック ソースがオフされます。これ

により、ディープスリープでは高速ペリフェラルは使用できなくなります。低周波数クロックで動作するペリフ

ェラルのみが使用可能です。  

▪ ハイバネートモード: デバイスと GPIO はフリーズ状態であり、デバイスはウェイクアップ時にリセットされま

す。 

バッテリ駆動の BLEシステムで、スリープ、ディープ スリープ、ハイバネート モードを組み合わせた使用により、

バッテリ寿命を延ばし、最高のシステム消費電力を達成できます。表 5 に、PSoC 6 BLE システム電力モードと

BLESS 電力モード間の依存関係を示します。表 5 でのチェックマークのあるセルは、システムにあたえられた電力

モードにあるときに、BLESS が指定されたタスクを実行できることを示します。例えば、BLESS は、システムが低

消費電力アクティブモードのときにディープスリープモードにできます。「データ保持」のセルは、システムがディ

ープ スリープ モードに切り替わった時に BLESS動作コンテキストが保持されていることを示します。 

表 5. PSoC 6 BLE消費電力モード 

BLESSモード 
PSoC 6 BLEシステム電力モード 

アクティブ 低消費電力アクティブ スリープ 低消費電力スリープ ディープ スリープ ハイバネート 

送信 ✓ ✓ ✓ ✓ データ保持 オフ 

受信 ✓ ✓ ✓ ✓ データ保持 オフ 

アイドル ✓ ✓ ✓ ✓ データ保持 オフ 

ディープ スリープ ✓ ✓ ✓ ✓ データ保持 オフ 

C.2 セキュア ブート 

セキュアブートには、市場／アプリケーション固有の規格で定義されているキーベースのセキュリティプロトコルを

使用し、アプリケーションのフラッシュイメージを認証する必要があります。セキュアブートプロセスは、SROM

および PSoC 6 BLEデバイスの個別の監視フラッシュに実装されます。ブートコードは、ブートコードのチェックサ

ムを計算し、それを eFuse の値と比較します。これらの値が一致しない場合、ブート プロセスは失敗します。ブー

ト コードは eFuse で指定されたデバッグ アクセス制限も適用します。セキュアブートはオプション機能であり、 

エンドユーザーが有効にする必要があります。 

C.3 プログラマブル デジタル ペリフェラル 

C.3.1  UDB 

図 68に示すように、UDBは CPLDおよび FPGAブロックと同様な機能を提供するプログラマブル ロジック ブロッ

クです。UDB を使用すると、タイマー、カウンター、PWM、疑似ランダムシーケンス (PRS) 、CRC、シフトレジ

スタ、SPI、UART、I2S、カスタムの組合せおよびシーケンシャルロジック回路など、さまざまなデジタル機能を作

成できます。 

各 UDBは 2個のプログラマブル ロジック デバイス (PLD) を持ち、それぞれ 12本の入力と 8つのプロダクト ターム

があります。PLD は登録済みまたは組合せ積和ロジックを形成できます。さらに、「データパス」として知られて

いる 8 ビットのシングル サイクル算術ロジック ユニット (ALU) が各 UDBにあります。データパスは、タイマー、

カウンター、PWM、および CRCなどの機能の効率的な実装に役立ちます。 
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また、UDBはペリフェラルやポートからの信号をUDBとの間でやり取りして通信や制御を行えるスイッチド デジタ

ル シグナル インターコネクト (DSI) ファブリックを提供します。 

図 68. 汎用デジタル ブロックダイヤグラム 

 

UDBを使用するために必ずしもハードウェア記述言語 (HDL) を知る必要はありません。サイプレスの PSoC 6 BLE

用開発ツールである PSoC Creator は、回路図から必要な機能を生成できます。必要に応じて、上級ユーザーは

Verilogを使用して UDBにカスタムロジックを実装できます。 

PSoC 6 BLE は最大 12 の UDB を持ちます。UDB の詳細については、次のアプリケーションノートを参照してくだ

さい。 

▪ AN62510 - Implementing State Machines with PSoC 3, PSoC 4, and PSoC 5LP 

▪ AN82156 - UDBデータパスを用いた PSoC Creatorコンポーネントの設計 

▪ AN82250 - PSoC Creatorによるプログラマブル ロジック設計の実装方法 

C.3.2  プログラマブル TCPWM 

PSoC 6 BLEは 32のプログラマブル TCPWMブロックを持ちます。各 TCPWMはタイマー、カウンター、PWMま

たは直交デコーダーとして実装できます。TCPWM はデッド バンド プログラマブル相補 PWM 出力と選択可能な起

動、リロード、停止、カウントおよびキャプチャ イベント信号を提供します。PWMモードは、中央揃え、エッジ、

擬似乱数操作をサポートします。またキル入力もあり、強制的に出力を既定の状態にできます。 

詳細は PSoC 6 BLE TCPWMコンポーネント データシートを参照してください。 

C.3.3  SCB 

PSoC 6 BLEには、I2C、SPI、または UARTを備えた最大 9つの独立したランタイムプログラマブル SCBがありま

す。SCBは以下の機能に対応します。 

▪ Motorola®、Texas Instruments®のセキュア  シンプル  ペアリング  (SSP) および National Semiconductor® 

Microwireプロトコルで標準 SPIマスターおよびスレーブの機能 

▪ スマートカードリーダー、シングルワイヤー ローカル相互接続ネットワーク (LIN) インターフェース、

SmartCard (ISO7816) 、および赤外線データアソシエーション (IrDA) プロトコルを備えた標準 UART機能 (最大

1Mbpsボーレート) 

▪ 動作速度最大 1Mbpsの標準 I2Cマスターおよびスレーブ機能 

▪ CPU介入なしで動作可能な EzSPIおよび EzI2Cモード 

▪ 1 つの SCB は外部クロックでディープ スリープ モードで動作するように設定可能。低消費電力 (ディープス 

リープ) モードは、スレーブモードでのみ SPIおよび I2Cプロトコル (外部クロックを使用) でサポートされる 

詳細については、PSoC 6 BLE SCBコンポーネントデータシートを参照してください。 
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C.3.4  BLESS 

PSoC 6 BLEは Bluetooth 4.2仕様で指定されている BLEリンク層と物理層を実装する Bluetoothスマート サブシス

テムが組み込まれています。BLE サブシステムには、AES-128 セキュリティエンジンが組み込まれた物理層 (PHY) 

とリンク層エンジンが含まれています。サブシステムは、Bluetooth SIGで定義されているすべての BLEプロファイ

ルをサポートします。 

物理層は Bluetooth 4.2 仕様に準拠したデジタル PHY および RF トランシーバで構成されます。トランシーバは

2.4GHz ISMバンド 1Mbpsで GFSKパケットを送受信します。ベースバンド コントローラーはマスターとスレーブ 

モードの両方に対応する複合ハードウェア／ファームウェアでの実装です。HCI やリンク制御などの重要なプロトコ

ル要素はファームウェアで実装されていますが、暗号化、CRC、データ ホワイトニング、アクセス コード相関など

のタイムクリティカルな機能はハードウェアで実装されます。 

BLESS は Bluetooth 4.2 準拠であり、Bluetooth 4.0 仕様のすべての機能と、低デューティサイクル アドバタイズ、

LE ping、L2CAP 接続指向チャネル、リンク層プライバシー、リンク層データ長拡張および LE 安全接続などの

Bluetooth 4.2仕様のいくつかの追加機能をサポートします。BLESSブロックには、正確なRF周波数を生成し、BLE

接続での連続する接続間隔間の時間をそれぞれ維持するために必要な ECOおよびWCOも含んでいます。 

BLEサブシステムは、最大 4つの同時接続をサポートします。ディープスリープ、アイドル、送信、および受信の、

4つの機能電力モードをサポートしています。  

注:  ここで説明する電力モードは BLESSブロックの固有のモードです。PSoC 6 BLEシステムの電力モードについ

ては、「電力モード」セクションを参照してください。 

C.3.4.1 ディープ スリープ モード 

ディープ スリープ モードは BLESS によりサポートされるもっとも低い消費電力モードです。このモードでは、無

線ブロックはオフです。パケットの送受信が完了した後、アドバタイズまたは接続間隔の間で最大の節電のため、こ

のモードになります。節電のためにこのモードで ECO をオフにできます。低周波数クロックである WCO は、BLE

リンク層のタイミング基準ロジックを維持するためにオンになります。アプリケーション ファームウェアは、この

状態に入ることと出ることを制御します。 

C.3.4.2 スリープ モード 

スリープ モードでは、無線ブロックはオフです。ブロックはすべての設定を保持します。ECO と WCO はオンです

が、コア BLESSロジックへのクロックはオフです。アプリケーション ファームウェアは、この状態に入ることと出

ることを制御します。  

C.3.4.3 アイドル モード 

アイドル モードは送信と受信状態の準備状態です。このモードでは、無線ブロックはオフですが、CPU がプロトコ

ル ステート マシンを起動するためにリンク層ロジックのリンク層クロックは有効にされています。 

C.3.4.4 送信モード 

送信モードはアクティブ機能モードです。このモードで、BLESS のすべてのブロックはオンになります。リンク層

クロックは、リンク層および RF-PHY 内のロジックを完成させるために有効にされます。このモードでは、RF-PHY

はリンク層から最大 2Mbpsのシリアルデータを取得し、2.4GHz GFSK変調データをアンテナ ポートに送信します。

BLESSはアイドル モードから送信モードに入ります。 

C.3.4.5 受信モード 

このモードは、BLESS が受信状態に入り、BLE 固有のレシーバー動作を実行できるようにします。RF-PHY は、RF

アナログ ブロックから受信した 1Mbpsデータを変換し、復調後にリンク層コントローラーに転送します。BLESS電

力モードと動作サブブロックの概要を表 6に示します。 
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表 6. BLESS電力モード 

BLESS電力モード ECO WCO RF Tx RF Rx BLESSコア 

ディープ スリープ  オフ オン オフ オフ オフ 

スリープ オン オン オフ オフ オフ 

アイドル オン オン オフ オフ オン 

送信 オン オン オン オフ オン 

受信 オン オン オフ オン オン 

C.3.5  オーディオ  サブシステム  

PSoC 6 BLEは、I2Sブロックと 2つの PDMチャネルで構成されるオーディオサブシステムを持ちます。PDMチャ

ネルは、デジタル マイクのビットストリーム出力とインターフェースします。PDM 処理チャネルはドループ補正を

提供し、384kHz～3.072MHz のクロック速度で動作でき、最大 48ksps のオーディオ サンプリング速度で 16～24 

ビットのワード長を生成します。 

I2Sインターフェースは、8 ビット～32 ビットのワードを送信する時、最大 192ksps のワードクロックレートでマス

ターモードとスレーブモードの両方をサポートします。 

C.3.6  シリアル  メモリ  インターフェース  

PSoC 6 BLEのシリアル メモリ インターフェース (SMIF) は、さまざまなタイプのメモリと最大 4つのメモリとのイ

ンターフェースが可能です。SMIFはオクタル SPI (8ビット/サイクルスループット)、デュアルクアッド SPI (8ビッ

ト/サイクルスループット)、クアッド SPI (4ビット/サイクルスループット)、デュアル SPI (2ビット/サイクルスルー

プット)、および SPI (1 ビット/サイクルのスループット)。このブロックは、CPU コアが外部メモリから直接コード

を実行できる実行インプレース (XIP) モードもサポートしています。PSoC Creator で用意されたソフトウェア モ 

ジュールとともに SMIF ブロックを使用すると、アプリケーションで適格な所定のメモリ デバイス セットを使用で

きます。 

C.3.7  eFUSE 

eFuseはセキュリティ関連の設定をプログラムするために使用されるワンタイム プログラマブルです。1度プログラ

ムされ、後で使用されるアプリケーション設定を保存するためにも使用できます。 

C.3.8  セグメント  LCD 

PSoC 6 BLEのセグメント LCD駆動は以下の特長があります。 

▪ 最大 8コモン (COM) と 64セグメント (SEG) 電極をサポート 

▪ プログラマブル GPIOにより、COMと SEGの電極のフレキシブルな選択が可能 

▪ 14 セグメントと 16 セグメント構成のキャラクタ ディスプレイ、7 セグメント構成のディスプレイ、ドット マ

トリクスおよび特殊記号をサポート 

▪ 2つの駆動モード: デジタル相関および PWM 

▪ ハイバネートを除くすべてのシステム電源モードで動作 

▪ 1.8ボルト VDDから 3ボルトのディスプレイを駆動可能 

▪ デジタル コントラスト制御 

注: PSoC 6 BLEデバイスでサポートされるコモンとセグメントの数は、デバイス ファミリとデバイス パッケージに

よって異なります。詳細は関連するデバイス データシートを参照してください。 

C.4 プログラマブル アナログ ペリフェラル 

C.4.1  連続時間ブロック  オペアンプ  

PSoC 6 BLEデバイスは、入力と出力が固定位置ピンに接続された連続時間ブロック (CTBm) ベースのオペアンプの

ペアを持ちます。オペアンプは、ハイバネートを除くすべての電力モードをサポートしています。しかし、オペアン

プは、ディープスリープモードで利得帯域幅積を低下させて動作します。一般的に、これらのオペアンプの出力は、

SAR入力のバッファとして使用できます。 
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C.4.2  低消費電力コンパレータ  

PSoC 6 BLEは、ディープスリープとハイバネートモードで動作もできる低消費電力コンパレータの 1対を内蔵して

います。コンパレータは低消費電力モードで 300nA 未満の電流を消費します。低消費電力の設計では、デバイスが

低消費電力モードに入った時、低消費電力コンパレータを使用してアナログ入力を監視し、システムを復帰させられ

る割込みを生成できます。 

詳細は PSoC 6 BLE Low-Power Comparator Component datasheetを参照してください。 

C.4.3  SAR ADC 

PSoC 6 BLEは、プログラム可能な解像度とシングルエンドまたは差動入力オプションをサポートする入力チャネル

を備えた 12ビット、1 Msps逐次比較レジスタ (SAR) ADCを内蔵しています。実装可能な ADC入力チャネルの数は

GPIO の数に依存します。SAR ADC は高速クロックを必要とするため、ディープ スリープ モードとハイバネート 

モードに対応していません。 

SAR ADC は、CPU の介入無しに最大 8 本のチャネルで自動スキャンを実行できるハードウェア シーケンサを備え

ています。SAR ADC は 8 入力シーケンサを介して、決められたピンに接続されます。シーケンサは、スイッチング 

オーバーヘッドなしで選択されたチャネルを自動的に (シーケンサ スキャン) 循環します。また、これらの 8 つの 

チャネルで出力データの累積や平均化などの前処理動作をサポートします。 

ファームウェアやタイマー、ピン、UDBなどを使用してスキャンをトリガでき、追加の設計の柔軟性を与えます。 

ノイズの多い状況でのパフォーマンスを改善するために、内部基準アンプに対して、外部バイパスコンデンサを固定

したピン位置に設定できます。SAR ADCの詳細については、PSoC 6 BLE SAR ADCコンポーネントデータシートを

参照してください。 

PSoC 6 BLEには、温度を測定するためのオンチップ温度センサーを内蔵しています。温度センサーは SAR ADCに

接続できます。SARADC は、校正と線形化を含むサイプレス提供のソフトウェアコンポーネントを使用し、読み出

し値をデジタル化し、温度値を生成します。 

C.4.4  DAC 

PSoC 6 BLEは 12ビット電圧モード連続時間 DAC (CTDAC) を持ち、セトリング時間は 2μsです。12ビット DAC

は外部のサンプルとホールド (S/H) 回路を必要とせずに連続時間出力を提供します。DAC 制御インターフェースに

より、CPUと DMAを介して DAC出力を制御できます。これはダブルバッファ DAC電圧制御レジスタ、プログラマ

ブル更新レート用のクロック入力、CPU に DAC の空バッファの割込みおよび DMA へのトリガが含まれます。この

ため、DACはユーザー定義の波形を生成するために DMAコントローラーにより駆動されます。 

DACの詳細については、PSoC 6 BLE DACコンポーネントデータシートを参照してください。 

C.4.5  CapSense  

PSoC 6 BLEデバイスの第 4世代 CapSenseは、自己容量と相互容量ベースのタッチセンシングをサポートします。

CapSenseはすべてのピンでサポートされます。 

静電容量タッチ センサーは、人体の静電容量を使ってセンサー上またはセンサーの近くの指の存在を検出します。

静電容量センサーは審美的に優れており、使い易く、長寿命です。PSoC 6 BLE の CapSense 機能はクラス最高の

SNR、クラス最高の耐液性、および広く多様なセンサータイプ (ボタン、スライダー、トラックパッド、および近接

センサーなど) を提供します。 

サイプレスが提供するソフトウェア コンポーネントは、静電容量センシングの設計を簡単にします。このコンポー

ネントは、SmartSense というハードウェア自動チューニング機能をサポートし、トラックパッドと近接センサーの

ジェスチャー認識ライブラリを提供します。 

詳細については、AN85951 – PSoC 4および PSoC 6 MCU CapSenseデザインガイドを参照してください。 

CapSense ブロックには 2 つの 7 ビット IDACがあります。CapSense がそれらを使用していない場合、これらは汎

用目的に使用できます。1つの IDACの使用により、(低速) 10ビット スロープ ADCを実現できます。スロープ ADC

の使用方法の詳細は PSoC 6 BLE CapSenseコンポーネント データシートを参照してください。 

http://www.cypress.com/
http://www.cypress.com/documentation/component-datasheets/psoc-4-low-power-comparator
http://www.cypress.com/an85951
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C.5 プログラマブル GPIO 

I/O システムは、CPU コア、ペリフェラル、および外部デバイス間のインターフェースを提供します。PSoC 6 BLE

は最大 104 本のプログラマブル GPIO ピンを備えています。CapSense、LCD、アナログ、またはデジタル信号用に

GPIOを設定できます。PSoC 6 BLEのGPIOは多くの駆動モード、駆動強度およびスルーレートに対応しています。 

PSoC 6 BLEは内部信号を GPIOに接続する多数のオプションを与えるインテリジェントな配線システムを提供しま

す。この柔軟な配線により、回路設計と基板レイアウトが容易になります。 

さらに、PSoC 6 BLE には最大 2 つのスマート I/O ポートがあり、GPIO ピンに入出力信号に対してブール演算を実

行するために使用できます。スマート I/Oポートは、ディープスリープモードでも動作します。 

http://www.cypress.com/
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Appendix D. サイプレス IoT開発ツール 

D.1 CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit 

図 69 に示す PSoC 6 BLE Pioneer Kit は、PSoC 6 BLE デバイス ファミリに対応しているサイプレスの BLE 開発 

キットです。 

以下に PSoC 6 BLE Pioneer Kitベースボードの機能を示します。 

▪ コイン型電池または Type-C USBインターフェースを介して受電することが可能。Type-C USBインターフェー

スは、最大 12V、3Aの電力供給 (PD) のコンシューマおよびプロバイダ プロファイルもサポート 

▪ 標準の Arduino Unoコネクタ準拠のシールド、CapSenseユーザーインターフェイスやシリアルメモリ インター

フェースなどのオンボード PSoC 6 BLE デバイス機能と連携して動作する、バッテリ駆動の低消費電力 BLE 設

計の開発を可能する 

▪ Cortex Debug/ETMコネクタを使用し、サードパーティのプログラミング、デバッグおよびトレースをサポート 

▪ Digilent などのサードパーティベンダーの Pmod™ドーターカードとのインターフェースをサポートする追加 

ヘッダを含む 

▪ ボイスオーバーBLE機能用の PDM-PCMマイクをサポート 

▪ QSPI NORフラッシュと F-RAMを含む 

本キットには以下が含まれます。 

▪ BLEリンクマスターとして機能し、CySmart ホストエミュレーションツールと連携して非 BLE Windows PC に

BLEホストエミュレーションプラットフォームを提供する USB-BLEドングル 

▪ E-Inkディスプレイ  

このキットには、ユーザーが独自の BLEアプリケーションを開発できるように、BLE サンプル プロジェクトと資料

1 式が含まれます。キットの最新版、キットデザイン、サンプルプロジェクト、およびドキュメントファイルを入手

するには CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kitウェブページにアクセスしてください。 

図 69. CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit 

 

D.2 CySmartホスト エミュレーション ツール 

CySmartホストエミュレーションツールは、PSoC 6 BLE Pioneer Kitのドングルを使用して BLEセントラル デバイ

スをエミュレートする Windows アプリケーションです。図 69 を参照してください。このアプリケーションは BLE 

Pioneer Kit の一部としてインストールされます。BLE コンポーネントを右クリックして起動できます。ペリフェラ

ルの BLEサービス、特性、および属性を調べて設定することで、GATTまたは L2CAP接続指向のチャネルを介して、

ご使用の PSoC 6 BLEペリフェラル実装をテストするためのプラットフォームを提供します。 

http://www.cypress.com/
http://www.cypress.com/go/CY8CKIT-062-BLE
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CySmart ホスト エミュレーション ツールを使用し、実現できる動作は以下に含まれますが、これらに限定されま 

せん。 

▪ BLEペリフェラルをスキャンして、接続できるデバイスを検出 

▪ サービスや特性などの、接続したペリフェラルデバイスの BLE属性を検出 

▪ 特性値とディスクリプタにもとづいた読み書き 

▪ 接続したペリフェラル デバイスからの特性通知および指示を受ける 

▪ BLEセキュリティ マネージャを使用して、接続したペリフェラル デバイスとの結合を確立 

▪ ペリフェラル デバイスとの BLE L2CAP接続指向のセッションを確立し、Bluetooth 4.2仕様に従ったデータ交換

を行う 

▪ サイプレスの BLEペリフェラル デバイスの Over-the-air (OTA) ファームウェア アップグレード 

図 70と図 71に、CySmartホスト エミュレーション ツールのユーザー インターフェースを示します。このツールの

セットアップおよび使用方法の詳細は、Helpメニューの CySmartユーザー ガイドを参照してください。 

図 70. CySmartホスト エミュレーション ツールのマスター デバイス タブ 

Advertisement and 

Scan Response Data

Discovered Device List

Log Window

Trusted Device List

http://www.cypress.com/
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図 71. CySmartホスト エミュレーション ツールのペリフェラル デバイス属性タブ 

Attribute Display 

and 

Configuration

List of Discovered 

Attributes

 

D.3 CySmartモバイル アプリケーション 

PCツールの他に、それぞれのアプリケーション ストアから iOSまたは Android向けの CySmartモバイル アプリを

ダウンロードできます。このアプリは、BLE用に iOSコア Bluetoothフレームワークおよび Android組込みプラット

フォームフレームワークをそれぞれ使用します。これは BLE 対応のスマートフォンを、ペリフェラル デバイスをス

キャンして接続できるセントラル デバイスとして設定します。 

このアプリは、直感的なGUIを使用して SIG採用の BLE標準プロファイルをサポートし、基本的な BLEサービスお

よび特性の詳細を抽象化します。BLE 標準プロファイルに加えて、アプリはサイプレスの LED と CapSense 実証例

を使用してカスタムプロファイルの実装をデモします。図 72 と図 73 に、CySmart アプリにおける心拍数プロファ

イルのユーザー インターフェースのスクリーンショットを示します。BLE Pioneer Kitのプロジェクト例を使用し、

アプリケーションを実行する方法については BLE Pioneer Kitガイドを参照してください。  

http://www.cypress.com/
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図 72. CySmart iOSアプリの心拍数プロファイルの例 

 

 

図 73. CySmart Androidアプリの心拍数プロファイルの例 

 

 

http://www.cypress.com/
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改訂履歴 

文書名: AN210781 – PSoC Creatorでの PSoC 6 BLE入門 

文書番号: 002-23474 

版 ECN 発行日 変更内容 

** 6214764 07/05/2018 これは英語版 002-10781 Rev. *Bを翻訳した日本語版 Rev. **です。 

*A 6858903 04/28/2020 これは英語版 002-10781 Rev. *Dを翻訳した日本語版 Rev. *Aです。 
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